VERITAS™
Microdissection Instrument

; 4 \ E‘l‘ - )"-}-"'..t' a;\
Version C
\ * For Research Use Only
ARCTURUS
Vs | f-"d'.-:\.l%‘{ 1



Veritas™ Microdissection Instrument

User Guide

13553-00
Version C

A\

ARCTURUS




/ ATTENTION - Please Read! \

Improperly moving this instrument, changing settings or installing third party
hardware or software may impact the functions of this instrument and result in a
billable service call.

Please not move this instrument, change settings, or install
any third party hardware without first contacting Arcturus
Bioscience. /

Phone: (888) 446-7911 ARCTURUS/

Qaﬂ support@arctur.com

Legal Notice

©2003-2005 Arcturus Bioscience, Inc. All Rights Reserved.
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Avenue, Mountain View, CA 94043, United States of America.
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Limited Warranty
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User Safety

User Safety

Please review the following precautions carefully to ensure safe
and effective use of the Veritas™ Microdissection Instrument.

All models of the Veritas instrument contains a Class 3b infrared
laser. The infrared beam from this laser 1s not visible. Avoid direct
skin and eye exposure to this laser radiation.

Instruments with a cutting laser (Models 703 and 704) contain a
Class 4 ultra-violet laser in addition to the Class 3b laser. The ultra-
violet beam from this laser is not visible. Avoid eye or skin
exposure to direct or scattered radiation.

The instrument itself is classified as a Class 1 laser device.

The Veritas instrument incorporates an interlock system that
cnables laser operation only when the instrument covers are on
and the front door is closed, and the interlock switches are not
defeated or bypassed. Do not modify or override the interlock
system.

Do not remove or modify any of the Veritas optical
components or subassemblies, except as described in “User
Serviceable Parts” on page 100.

Please note the warning labels on the instrument. They are shown
here.

\ , CAUTION —CLASS 3B INVISIBLE LASER RADIATION WHEN OFEN
) AND INTERLOCKS DEFEATED

AVOID EXFOSURE TO THE BEAM

150 mi' maxmum output 204212 nm
|EC BO0225 11993+ A1 1907 a2 2001

Figure 2-1. Warning for capture laser

\ . CAUTION— CLASS 4 INASIBLE LASER RADIATION WHEN OFEN
AMD INTERLOCKS DEFEATED
AVOID EYE OR SKIN EXFOSURE TO

DIRECTOR SCATTERED RAD ATION
T, 250 pl 15 ne puke maximum output at 2499 nm
|EC G0225 1:1993+A1 1997 +A2: 2001

Figure 2-2. Warning for cutting laser

Any modifications to the Veritas Microdissection
Instrument, will void the system warranty.

The Veritas Microdissection Instrument is for indoor use
only.

CLASS 1LASER FRODUCT

Version C 888.446.7911 650.962.3020
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Symbols

A CAUTION: Consult accompanying documents.

A CAUTION: Hot surface!

A CAUTION: Possible pinching!

A CAUTION: Eye shield required!

o P>
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Installation

Installation

Installing Software Upgrades

FEach version of the software is accompanied by detailed
mstructions for updating an existing installation. Please follow the
update instructions distributed with the software.

Instructions for Lifting and Carrying

The Veritas™ Microdissection Instrument 1s shipped from the
factory with internal tie-downs and support hardware for its
protection. These should be reinstalled before relocating the
mstrument. The instrument is heavy, and the use of the hydraulic
lift, detachable handles, and support base originally shipped with
the instrument is recommended. Place the support base on the lift
and slide the instrument onto it applying force to the handles
rather than the sides of the instrument.

Detailed Installation Instructions

A CAUTION - Failure to correctly install the instrument may
result in damage that is not covered by the warranty.

If you encounter any difficulties, use the following resources to

resolve your problems:

*  Refer to “Maintenance and Troubleshooting” on page 95.

. Refer to document #13600-24 on the Veritas installation
CD.

. Contact customer support at Arcturus Bioscience
1 (888) 446-7911 (USA toll-free) or at (650) 962-3020. You
can also send email to techsupport@arctur.com.

If you prefer, Arcturus will be pleased to arrange for professional
mnstallation of your instrument.

Gather Equipment
You will need the following tools for the installation:
. #2 Phillips screwdriver
. 3/8" slotted screwdriver
. 9/16" wrench
. Hex keys of the following dimensions:
o 7/64"
e 2.5mm
* 3 mm

* 5mm

*  Cutting pliers or shears (for plastic zip ties)

Version C 888.446.7911 650.962.3020
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Prepare the Site

You will need:

Stable laboratory bench capable of supporting 400 Ib.
(200 kg)

Work surface 36 x 72in (90 x 180 cm) with 32 in (80 cm)
vertical clearance.

Electrical Supply: 100-240 VAC, 50-60 Hz, 600W, voltage
fluctuations not to exceed £10% of nominal supply voltage.

Temperature 18°-30°C, Relative Humidity < 60%.

Unpack the Instrument

1.

5.

Release crate latches and attach front panel as ramp (see

photo).

Use the #2 Phillips screwdriver to remove small side panels

near the bottom of the left and right sides (see photo).

* Using the 9/16" wrench, remove the four screws that
secure the Veritas™ Microdissection Instrument platform
to the support, near the strap buckles and on the other
side.

* Remove the straps. (Crate shown without sides for clarity;
see photo.)

Verify the instrument platform is secured to the jack with
three clamps.

Jack the instrument off the shipping supports and roll down
the ramp.

Remove the bag from the instrument.

Complete Back Side Preparation

1.

2.

Remove the top cover.

* Usc the slotted screwdriver to loosen the two screws at top
rear of instrument securing top panel.

* Slide the top cover back and lift up to remove.

* Place in a secure location.

Remove the front cover.

* Loosen the two screws at top back side of the front panel.

* Pull the top of front panel forward until the snap-locks
release and tilt the panel forward.

Remove all four of
these panels; two
on each side

Remove all four of these
screws; two on each side

8
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* Disconnect the three cables from the printed circuit board
on the front panel in this order: red/black, green/yellow
and gray ribbon.

* 'Tilt the front panel forward and lift to remove.

¢ Place in a secure location.

3. Remove the center-rear cover by removing screw, tilting the
top outward ~5cm (2 in.) and lifting clear.

4. Models 702 and 704 only, at the rear of the instrument:
* Clip and remove orange zip tie from light guide.
* Remove red shipping bracket from light guide.

5. Replace and secure the center-rear metal cover.

Place on Laboratory Bench

A CAUTION: The instrument weighs 120 kg (265 pounds). Use
appropriate care.

1. Use foot pedal to jack instrument to table height.

2. Use handles to lift instrument over plywood stops and slide
onto table.

Complete Front Side Preparation
NOTE: Re-install all screws and washers except as noted. Save

brackets and foam for future use. Take care not to drop screws or
washers.

1. Remove all five red shipping brackets:

* Objective turret support (Use the 7/64" hex key for the
top screw, 3 mm hex key for bottom screws)

* Objective turret rotation (Use the 2.5 mm hex key for two
SCIews.)

* Condenser lens (Use the 2.5 mm hex key for two screws.)

* 'I'wo brackets on the X-Y stage (may be silver colored; see
photo) (Use the 7/64" hex key for two screws.)

2. Remove protective foam from:
* Between objective turret spring and turret (seec photo)

Remove foam from here

Version C 888.446.7911 650.962.3020
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3.

4.

5.

* Models 702 and 704 only: Under filter wheel (see photo)

Remove green tape from the following locations
* Cap robot front-back motor

* Cap robot up-down motor

* Cap off load tray (2 picces)

Remove zip ties from:

* Cap robot cap fork (white) (see photo)

NOTE: You may need to move fork assembly forward to do
this. Verify that the motor is unplugged (see photo on next
page) and pull toward you on the right side of the assembly,
near the lead screw.

* Front panel above door (orange) (see photo)

Remove the two lock-down screws securing the vibration-
1solated microscope structure to base. (Use the 5 mm hex key
for two screws.)

* Mo6x20 screw near the front below the stage ribbon cable
(see photo)

* M6x20 screw behind the Hitachi camera (see photo)

Remove foam
from here

Remove this lock-
down screw

—_ Remove this lock-

down screw

6. Connect the cable at the cap robot front-back motor (see

photo).
7. Ensure the stage insert for slides s fully seated by pushing the

front edge inward.
8. Verify that the 20x and 40x (or 60x) objective correction rings

are at the 1.0 mark. Correct if necessary.
10 www.arctur.com techsupport@arctur.com 650.962.3020 888.446.7911 Version C
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9. Replace front cover.

* Place bottom clips over front edge of base

* Reconnect the three cables to the circuit (gray ribbon,
green/yellow, then red/black)

* Align snap clips with mating parts, ensuring cables are out
of the way.

* Push the cover foward until it snaps into place.

* Secure with two thumbscrews.

10. Replace top cover.
* Setinto place ~10cm (3 in.) from front
* Slide forward.
* Securely tighten two thumbscrews.

11. Remove label covering the power entry module plug;

Set Up and Connect Computer

1. Unpack PC and monitor boxes and set up according to
manufacturer’s instructions.

2. Connect the computer to the instrument with the serial cable
and video cable. See the figure on page 12 for details of the
connections.

Serial cable to
instrument

USB Keyhoard/
Mouse

Monitor

Video cable to
instrument

3. Position the monitor, keyboard and mouse for comfortable
operation.

4. When you have completed the installation, please perform
the installation qualification below.

Version C 888.446.7911 650.962.3020 techsupport@arctur.com www.arctur.com 11
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Figure 1. Veritas™ Microdissection Instrument connections
(top view)
Installation Qualification
*  Verify the instrument is supported on a stable bench or table
capable of supporting 200 kg.
*  Verify the instrument has at least 8 cm of clearance at the
sides, rear, and top for air circulation.
*  Verify the monitor, mouse and keyboard are arranged for
comfortable operation.
*  Verity the laboratory temperature and relative humidity are
within the specified limits.
*  Verify the electrical supply is compatible with instrument
specifications.
*  Verity the PC voltage selection matches the electrical supply
voltage.
If any of the above requirements is not met, identify and correct
the problem before powering the instrument.
*  Turn the instrument and computer on and wait 2—3 minutes.
Verify the Veritas application launches without error
messages.
12 www.arctur.com techsupport@arctur.com 650.962.3020 888.446.7911 Version C



Introduction

1. Introduction

The Veritas Microdissection Instrument

The Veritas™ Microdissection Instrument provides an automated
approach to microdissecting individual cells or multi-cellular
structures from slides containing tissue sections or cytological
samples.

The Veritas Microdissection Instrument consists of the Veritas
instrument, a computer and the Veritas software application.

Figure 1-1. Veritas Microdissection Instrument

Veritas Instrument Configurations
There are four models of the Veritas Microdissection Instrument:

*  Model 701: IR capture laser only
*  Model 702: IR capture laser with epi-fluorescence
*  Model 703: IR capture laser and UV cutting laser

*  Model 704: IR capture laser and UV cutting laser with epi-
fluorescence

With models 703 and 704, the cutting laser allows for quick
capture of large regions of tissue. Additionally, a cutting laser
allows you to ablate — remove via photo volatilization — tissue that
1s not of interest, to ensure higher purity samples.

With models 702 and 704, you can perform LCM on fluorescence
labeled samples. The fluorescence source is the X-Cite 120 from
EXFO Photonics Inc.

The standard system has four objectives for the microscope: 2x,
10x, 20x and 40x. A 60x objective and associated firmware can be
installed in place of the 40x by qualified Arcturus service
personnel.

Version C 888.446.7911 650.962.3020
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Veritas™ Microdissection Instrument

For sample visualization the instrument utilizes a PAL-format
color video camera.

For sample visualization and dissection for fluorescence
applications, the system uses an illuminator and three filter cubes —
red, green and blue excitation — as well as a fourth position for a
user-installed special purpose cube or factory-installed optional
UV excitation filter cube.

See “Specifications” on page 105 for excitation and emission
wavelengths and “Interchanging Fluorescence Filter Cubes” on
page 101 for instructions for installing filter cubes.

What is LCM?

Laser capture microdissection (LCM) is a method to quickly and
easily procure specific cell populations from standard histological
slides, using a low-power infrared laser (referred to as the “capture
laser” in the rest of the document) to activate a special
thermoplastic film over the cells or tissue of interest. The activated
transfer film adheres to the cells that are located within the laser
beam diameter. The laser does not affect the tissue sample; the
quality of nucleic acids and proteins within the sample and the cell
morphology are not compromised.

In the Veritas™ Microdissection Instrument, specially designed
CapSure™ HS or CapSure™ Macro Caps that are coated with this
film are placed on the tissue section of interest. The instrument
directs the laser through the cap to activate the film onto the
selected cells. The cells adhere to the cap surface when it is lifted
from the tissue section while the surrounding tissue remains intact
on the slide. The cap can be placed directly into a microcentrifuge
tube for extracting DNA, RNA or protein.

What is “Cut and Capture”?

Photoablation, the volatilization of tissue by light emitted from an
ultraviolet laser, can be used in conjunction with the IR capture
laser. In one application of photoablation, a relatively wide “moat”
is ablated around the region of interest and then the remaining
cells are captured by the capture laser. This minimizes
contamination of the cells due to collateral pick up during the
capture process. This “cut and capture” method can be used for
tissuc mounted on regular glass slides.

An alternate “cut and capture” method can be used for tissue
mounted on membrane (such as 2pm thick polyethylene
napthalate (PEN), cither on glass or in a metal frame). Here, the
cutting laser is used to cut a narrower outline around the region of
interest after which the entire region within the outline is captured.

Other Uses of the Veritas Microdissection Instrument

The cutting laser can also be used for negative selection. In this
application, undesired material is ablated, leaving behind the

The Laser Capture Microdissection Process

- -"-‘Eﬁ
L swm
(il
p————rd

1. Place cap on tissue.

4. Extract molecules from target cells.

14 www.arctur.com techsupport@arctur.com
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Introduction

material of interest. You may also remove the region of interest
manually (L.e. the capture laser is not used).

Work Surface

The Veritas instrument’s work surface is where the slides and caps

cap quality control (QC) station

are located, as well as the stage for the microscope. Use the
following guidelines when loading materials on the work surface:

Unload Tray
Place the unload tray in the unload slot with the handle facing

towards the front.
NOTE: To avoid instrument damage, always be sure the unload

tray is correctly positioned.

Caps

Push cap cassettes all the way back within the slot. If you are using

a single cassette, be sure to push it all the way to the back.

Slides
Push the tension lever to the left and place the slide in the opening unload ~ €@p )
of the slot. Push the slide all the way back in the slot. The tension tray ~ Cassettes sldes
lever will keep it securely in place.

Computer

The Veritas Microdissection Instrument includes a computer and
an LCD monitor. The computer includes the Windows operating
system and basic Windows applications, as well as the Veritas
application to control instrument operation.

Additional Materials

CapSure™ Macro Caps

CapSure Macro Caps provide a large surface area to capture several
thousand cells on a single cap. With CapSure Macro Caps, the
polymer surface is completely flat, so the entire surface can be used
to capture cells. Following LCM, the caps can be placed directly
onto a 0.5-mL. microcentrifuge tube containing extraction buffer.

CapSure™ HS Caps

CapSure HS Caps provide low-volume extraction and analysis of
highly specific LCM-captured material. The surface of the
CapSure HS Cap has a 12-um discontinuous circular ridge that sits
on the surface of the sample during LCM. This ridge keeps the full
surface of the cap elevated above the sample during LCM. Thus,
the polymer on the cap surface comes in contact with the sample
only where the polymer is activated by the laser.

CapSure™ LCM Sample Preparation System
Includes:

. CapSure HS Alignment Tray

Version C 888.446.7911 650.962.3020 techsupport@arctur.com www.arctur.com 15
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*  Incubation Block
*  PrepStrips™ Slide Preparation Strips

. ExtracSure™ Sample Extraction Devices

Cap Insertion Tool
The Cap Insertion tool is used to facilitate removal of CapSure
Caps from the unload tray.

Membrane Slides

With instruments equipped with a cutting laser and PEN
(polyethylene-napthalate) membrane slides, you can swiftly and
precisely capture large regions using the cut and capture method
described above.

MD

PEN membrane frame slide PEN membrane glass slide

Figure 1-2. Membrane slides

These slides are available from Arcturus.

Slide Catalog Number
PEN membrane frame slides LCMO0521
PEN membrane glass slides LCMO0522

About the PDF Version of the Manual

This manual is also distributed as a PDF (portable document q:!}r:]

. . o . .
format) file, installed Wlth the Veritas application. You will need \lndicates dlickable link
Adobe® Reader®, version 5.0 or greater, to open the file.

In the PDF version, when the document references a different
section or chapter, the cursor in Acrobat Reader will change to a
finger. You can click on the text with the section name or the page
number to go immediately to that section. For example, if the
sentence says: See “View Menu” on page 63 click on “View Menu”
or the page number to go to page 63.

You may also click on any page number in the table of contents or
the index to go immediately to the corresponding item.

16 www.arctur.com techsupport@arctur.com 650.962.3020 888.446.7911 Version C



Easy Access to Microdissection

2. Easy Access to Microdissection

This chapter explains how to use the Veritas™ application to
perform laser capture microdissection (LCM). For a more detailed
mtroduction to the application, please see Chapter 3, “System
Overview” on page 31.

LCM consists of the following steps. Hach step is described in
more detail on the corresponding page.

*  Tissue Preparation — page 17

. Startup — page 19

. Loading Materials — page 19

. Marking the Cells for Capture — page 21

. Creating Additional Capture Groups — page 24

. Capturing Cells — page 24

. Inspecting Captured Material — page 25

. Capturing Additional Capture Groups — page 27

. Unloading and Removing Caps — page 26

. Extracting Captured Tissue from the Caps — page 27
See “Overview of Additional Microdissection Methods” on

page 53 for information about other microdissection modes
available with the Veritas Microdissection Instrument.

Tissue Preparation

Tissue sections prepared from both frozen and formalin-fixed
paraffin-embedded tissue can be used for LCM. Freezing tissuc
helps ensure the integrity of the biological molecules within the
cells. Thus, cells captured from frozen tissue sections provide
material that 1s suitable for many downstream molecular biology
applications. This is especially true for applications requiring intact
RNA. While the integrity of the RNA from formalin-fixed tissue
may not be as optimal as that from frozen tissue, using the
recommended reagents will allow you to use these samples for
molecular biology applications as well.

Arcturus  provides an application note describing  the
recommended protocol for working with frozen samples:
Application Note #1, Optimized Protocol for Preparing and Staining
LCM Samples from Frogen Tissue and Exctraction of High Quality RINA.
This note can be found on the Arcturus web site at
www.arctur.com.

Version C 888.446.7911 650.962.3020
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Veritas™ Microdissection Instrument

NOTE: For optimal sample preparations of frozen tissue
samples and downstream processing, Arcturus recommends the
following reagent kits:

Reagent Kit Catalog Number
HistoGene™ I.CM Frozen Section KIT0401

Staining Kit

HistoGene LCM Immunofluorescence KIT0420

Staining Kit

PicoPure™ RNA Isolation Kit KIT0204
PicoPure DNA Isolation Kit KIT0103
RiboAmp® HS RNA Amplification Kit | KIT0205

Formalin-fixed, paraffin-embedded tissue may also be used for
LCM for DNA and protein work. Suggested protocols based on
the experience of Arcturus customers are available on the Arcturus
web site. For gene expression profiling studies using formalin-
fixed paraffin-embedded tissue, Arcturus recommends using the
Paradise™ Reagent System. This system provides all the reagents
for sample preparation, RNA extraction, isolation and lincar
amplification of the RNA, for use in microarray or quantitative
real-time PCR applications.

NOTE: For optimal sample preparations of formalin-fixed,
paraffin-embedded tissue samples and downstream
processing, Arcturus recommends the following reagent systems:

Reagent System Catalog Number
Paradise™ Reagent System, 1.5 rounds KIT0301

of amplification for use with Affymetrix | (48 reactions)
GeneChip® Arrays KTIT0311

(12 reactions)

Paradise Reagent System, 2 rounds of
amplification for use with cDNA arrays

KIT0302

(48 reactions)
KIT0312 (
12 reactions)

Paradise Reagent System for
Quantitative Real Time PCR

KIT0300L
(48 reactions)
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Startup

1. Turn on the computer.

2. ‘Turn on the Veritas™ Microdissection Instrument.
The power button is located on the left side of the
instrument, towards the back.

3. Start the application by double-clicking the Veritas icon on
the desktop.
—or—

Click Start, point to Programs and click Veritas.

Loading Materials
1. Login.

The System Login dialog box appears automatically when
you start the Veritas application.

* Enter your user name and password.
¢ (Click New Session.

The instrument door opens, the work surface slides out and
the application displays following message:

2. Load your slides and caps.

NOTE: If nceded, remove any caps that may have been left
in the QC station, the unload tray or on any slides.

* Place your slides in the appropriate locations on the work
surface. Push the tension lever to the left and place the
slide in the opening of the slot. Push the slide all the way
back in the slot. Make sure the slides are seated propetly.

* Slide the CapSure™ cassettes into the appropriate slot on
the work surface. If you are using a single cassette, push it
all the way to the back of the slot.

* Place the unload tray in the slot with the handle facing
towards the front. Make sure the unload tray is securely in
place.

3. Click OKin the message.
The work surface slides in, the instrument door closes and
the system automatically performs material detection,

identifying the number and types of slides and caps you have
loaded.

If you do not have the Use Material Detection option sct
(see “Setting User Preferences” on page 36), the Materials

)

Weritas

Uszer Mame: ||

Password: I

Mew Seszzion I Ok | LCancel |

veritas x|
! E after Loading Material, Select Ok
L

cap quality control (QC) station

unload  @P )
tray cassettes slides
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6.

Loading window appears and you must manually enter the
details about your slides and caps, as described in “Entering
Information in the Materials Loading Window” on page 67.

If you are using the AutoPix 100e, the Materials Loading
window will a/ways appear and you must enter the details for
your slides and caps.

Once materials detection is complete, the system
automatically performs the following actions for each slide,
starting with the slide in the highest numbered slot:

* Displays the live video window.

* Once the live video window is open, the system

automatically adjusts the brightness and focuses the live
video image.
NOTE: If you do not have the Auto Focus and/or Auto
Brightness Adjust options set (see “Setting User
Preferences” on page 36) you will need to manually set the
brightness and/or focus the live video; see “Manually
Focusing the Live Video” on page 51.

* Acquires and displays a roadmap for the slide.

NOTE: If you do not have the Auto-acquire Roadmap
Images option set (see “Setting User Preferences” on
page 36), you will need to manually acquire a roadmap. To
do this, activate a slide in the Materials Tool by clicking it,
then right-click and choose Acquire Roadmap Image.

Move the stage to display an area of interest in the live video
image. To use a slide other than what is displayed, double-
click on the slide in the Materials Tool or click the Slot button
corresponding to the slide of interest. The roadmap for the
selected slide will be displayed.

When the live video window is the active window, the cursor
turns into a hand. Click and drag the mouse to move the
stage to display a regions of interest.

In addition to moving the stage with the hand, you may
move the stage in any of the following ways:

* Press the Ur, DOWN, LEFT and RIGIHT arrow keys to
move the stage a small amount.

* Hold down the CONTROL key while pressing an arrow key
to move one half of the field of view at a time.

You can save the locations of areas of interest so you may
easily return to them. See “Saving Positions of Interest” on
page 84 for more information.

If you are performing fluorescence LCM, turn on the
fluorescence lamp by clicking the Fluorescence button in
the Microscope Tools. The fluorescence lamp needs several

M #0 Roadmap Image for Slide #2221

Red dotted line defines area
where center of cap may be
placed

“—Red view indicator
defines area displayed in
live video window
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Easy Access to Microdissection

minutes to warm up to reach its maximum light intensity.
When it is ready, the message “EPI Ready” appears in the
lower-right corner of the screen.

(See “Microdissection of Fluorescent Samples” on page 52
for more information.)

7. 'lo view the cells and tissue you wish to capture, change the
objective as needed, by clicking in the Microscope Tools.
Each time you change the objective, the instrument should
automatically adjust the image brightness and focus the
MICroscope.

Marking the Cells for Capture

Use the individual tools in the Microdissection Tools to mark the
cells for capture and/or ablation. These marks are referred to
collectively as “dissection marks™.

NOTE: If your instrument is equipped with a cutting laser
(Models 703 and 704), you should mark your cells at oze objective
power and then initiate cut and capture. This ensures the cutting
laser will most accurately follow the dissection marks.

The Microdissection Tools are arranged on three tabs:

*  Cutand Capture (Models 703 and 704 only); use these tools
to mark larger regions for capture using a combination of
laser cutting and capture.

. LCM; use these tools to mark single cells or regions for
capture.

*  Ablate (Models 703 and 704 only); use these tools to mark
areas to be ablated.

See “The Microdissection Tools” on page 80 for more detailed
information about these tools.

Common Microdissection Tools

In addition to the tools used to mark cells, there are four tools
common to each tab:

* Hand
Use this tool to move the stage. By default, this tool is always T
active in the live video. E |
*  Ruler

Use this tool to measure distances in the live video window.
See page 80 for information on using the ruler. e

*  Go Capture -
Once you have marked cells, this tool initiates the cut and
capture process. See “Capturing Cells” on page 24 for more f/’é
information. e

o Autoscan
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Click this to begin training the system to automatically
identify cells for capture. See “Introduction to Auto Scan on Suboscan |
a Static Image” on page 55 for detailed instructions on this

feature.

Activating a Microdissection Tool

To activate a tool, click on it. The tool remains active until you
click the tool again, which will turn it off. When you turn off a tool,
the Hand tool becomes active so you can move the stage. You can
use the arrow keys to move the stage while a tool is active.

Changing Properties of the Dissection Marks

You may change the properties of any dissection marks, such as
the number of capture laser spots or width of the cut. See
“Adjusting Dissection Mark Properties” on page 83 for more
information.

Cut and Capture Tools

If you have a cutting laser in your Veritas™ instrument (Models x|

703 and 704), the Cut and Capture tools are available and allow Cut and Capture | LCM | Ablate |

you to mark larger regions for capture. _\.ﬂ‘d ﬂ g ﬂ J ﬂ ot |

If you wish to capture single cells or smaller regions, use the LCM
Dissection Tools, described below.

If you wish to ablate an area, use the Ablation Tools, described on
page 23.

The tools on the Cut and Capture tab are:
*  FPree-Form Cut and Capture Region
*  Circular Cut and Capture Region
These tools are described briefly below:

Free-Form Cut and Capture Region — Use this tool to draw a
free form region to be captured.

Circular Cut and Capture Region — Use this tool to draw a
circular region to be captured. l:::::l

After you have marked cells with either of these tools, the
application will display the outline of the region and the capture
laser spots on the live video image.

LCM Dissection Tools
These tools allow you to mark cells and smaller regions for x|
capture. Cut and Capture  LCM |Ablate|

To capture larger regions more quickly, use the Cut and Capture _\EJJ ﬂ j ﬂ ﬂ J ﬂ .-’-\utosc:anl

Tools, described above.

If you wish to ablate an area around a region to be captured, use
the Ablation Tools, described below.
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The following tools are available on the LCM tab:
. Single Point Dissection

. Dissection Line

. Dissection Region

*  Dissection Exclusion Region

These tools are described briefly below:

Single Dissection Point — Use this tool to target individual cells
for capture.

Dissection Line — Use this tool to draw a line on the image to
capture a layer or line of cells, for example, to capture an epithelial
cell layer.

Dissection Region — Use this tool to draw a region on the image
to identify an area to be captured.

Dissection Exclusion Region — Use this tool to desclect a
specific area that you don’t want to capture within a previously
marked region. This tool is only enabled when you have a
dissection region selected.

After you have marked cells with these tools, the application will
show the marked regions as spots on the live video image, using
the spot size of the capture laser.

Ablation Tools

If you have a cutting laser in your Veritas™ instrument (Models
703 and 704), the following tools are available and allow you to
mark regions of tissue to be ablated.

To capture larger regions quickly, use the Cut and Capture Tools,
described on page 22.

To capture single cells or smaller regions, use the LCM Dissection
Tools, described on page 22.

The tools on this Ablate tab are:

. Free-Form Ablation Region

*  Ablation Exclusion Region

These tools are described briefly below.

Free-Form Ablation Region — Use this tool to draw a region to

be ablated.

Ablation Exclusion Region — Use this tool to draw a region that
is excluded from a region to be ablated. This tool is only enabled
when a free-form ablation region is selected.

After you have marked cells with these tools, the application will
display the regions to be ablated as a solid area in the color for the
current capture group.

Microdissection

Cut and Eapturel LCH  Ablate |

Xl

2
@
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Creating Additional Capture Groups

You may wish to designate groups of tissue to be captured
together. For instance, you may have two different types of cells
on one slide, both of which you are interested in assaying. You can

create different groups, one for cach type of cell. When you
capture, you can capture the first group on one cap and the second

group on another cap.

By default, all marked cells belong to the first capture group.

You can designate a total of eight capture groups, as follows:

1.

2.

3.

4.

In the Capture Groups Tool, click on the row for the new
group.

If desired, type the name of the group in the Name cell in the
selected row.

Mark the cells for capture with any of the Microdissection
Tools, as described above.

You may set different properties for each capture group, such
as the color that the capture group will be displayed on screen
or the cut width of the cutting laser. See “Adjusting Capture
Group Properties” on page 74 for details.

Capturing Cells

1.

If desired, review the items in each capture group. Click the
row for the capture group of interest, then click buttons at
the bottom of the Capture Groups Tool to move through the
items in that capture group. The stage will move and the live
video image will update as needed to display each item in the
capture group. The area of the currently selected item is
shown in the Area ficld.

Click the Go Capture button. The instrument does the
following:
* DPerforms all cuts and/or any ablation.

If the 2x objective is selected when you click Go Capture,
the instrument switches to the 10x objective and auto-
focuses before initiating any cuts. Once cell capture is
complete, the instrument switches back to the 2x objective.

NOTE: The cut may be too narrow to be visible at 2x. To
inspect the cut, switch to a higher objective.

Depending upon the type of slide you have loaded, the
details of the cutting vary.

* For glass skides — The instrument cuts a moat around the
region of interest. The width of the moat is set in the Cut
Width ficld in the Cut Properties tab of the Capture

Groups Name Mumber Area
a clear 2 2.11mm?
H B suspicious — 1.99mm?
m C i] Oprn®
| ] i] Oprin2
E 1] Oprn?
F n M2
1| I 4

K] <« [

]

Hrea W

CFg:

ﬂ .ﬁ.reaw |

First Previous Next Last

A

Properties
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Group Properties dialog (see “Adjusting Capture Group
Properties” on page 74).

» For membrane skdes (including membrane frame slides) — The
mstrument cuts around the region of interest, leaving tabs.
Tabs are short stretches where the cutting laser will not cut.
Tabs keep the tissue from cutling up from the surface of
the slide before the capture laser can fuse it to the cap. The
number of tabs, their size and spacing are set in the Cut
Properties tab of the Capture Group Properties dialog (see
“Adjusting Capture Group Properties” on page 74).

When the cutting laser has completed cutting, the instrument
places a cap over the slide and the Cap Properties window
appears.

In the Cap Properties window, enter a name for the cap (or
use the default name) and any notes you wish to save with the
cap data. Click OK.

An outline of the cap appears on the roadmap indicating its
location.

Once the cap has been placed, the instrument continues with

the capture process, and does the following:

* Locates the capture laser and focuses it.
See “Manually Locating the Capture Laser” on page 50
and “Manually Focusing the Capture Laser Beam” on
page 49, if necessary.

* FPires the capture laser at the position of each capture laser
spot, to fuse the cells to the cap.

Inspecting Captured Material

Following cell capture, you should inspect the slide and the cap to

verify that the collection was successful. To view the cap, you
should move it to the QC station.

Cap Propetties x|

Cap Data |

Cap Name: |[EEEE

CaplD: 229 Cap Type: Macro
Cap Motes:

Area Fire
’7|u.uu i [ ‘ ]

QK. I Cancel | Lpply Help

1. Review each item in the capture group on the slide to verify it li o
was completely captured, using the buttons at the bottom of llj |< |T e i
the Capture Groups Tool. ‘

First Previous Next Last Properties

2. If cutting or capture was incomplete, you may cut and/or
capture again. See page 64 for instructions on how to repeat
cutting and capture.

3. Right-click the cap on the active slide and choose Move To,
then select QC.

—or—
Click and drag the cap from the active slide to the QC
station.
NOTE: To automatically move the cap from the slide to the
QC station at the completion of a capture or after Auto Scan,
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4.

sclect the Move Cap To setting in User Preferences (see
“Setting User Preferences” on page 30).

When the cap has been moved to the QC station, the
application will display the cap in the live video window,
where you may inspect the captured tissue.

If you have a cutting laser, you may ablate any unwanted
tissue from the material on the cap. There are two modes for
ablating:

* Click ALT+X to turn on the cutting laser, and use the
mouse to move the region you wish to ablate under the
laser spot. When you are finished, click ALT+X to turn off
the cutting laser.

* Hold down the CONTROL and StIFT keys at the same
time. Move the mouse to move the area of tissue under the
laser spot. The cutting laser fires only while the keys are
depressed. When you release the keys, the laser turns off.

Unloading and Removing Caps

1.

Move the cap to the unload tray in one of the following ways: _lol x|
Click and drag the cap from the QC station (or the slide, if il e el
. . < . .. . Cap Interaction History =]
you did not move it to the QC station) to any position in the
unload tray. Tray Map:
— Or p— W
1‘(*
Right-click the cap in the QC station agd choose Mov.e To, e SO DR
then select Unload. The cap is placed in the next available
location on the unload tray.
Tray Map:
2. Click Open Door in the Materials Tool. The instrument door X
opens and the work surface slides out. Le
The Cap Interaction History appears on the screen, in Ly - R
Notepad. (If you have not placed a cap, the Cap Interaction o e S
History is not shown.)
Captured from the following slides:
slide name: Slide #6 slide Type: MEMERANE
s1ide Note:
Total cCaptured area (micron®%2): 0.000000
ki iz
3. Close Notepad, saving the history if desired. The unload
materials message appears. ! } After Unloading makerials, Press OK ko Close the Daaor
4. Slide the cap insertion tool onto the unload tray. Make sure
the open end of the mnsertion tool faces the suspended cap
and slides over the empty cap receptacles.
5. Slide the insertion tool towards the cap until the cap is
engaged.
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6. Remove the insertion tool from the unload tray. The cap
should be attached to it.

NOTE: Be sure you do not touch the polymer surface that
holds the captured cells as you remove the caps from the
unload tray.

7. Repeat steps 4., 5., and 6. for each cap in the unload tray.
8. Click OK to close the instrument door.

9. If you only have one capture group, log out and exit the
application as described on page 31, under “Shutdown”.

Capturing Additional Capture Groups

If you assigned dissection marks to more than one capture group
in the Capture Groups Tool, you can capture the next group.

1. In the Capture Groups tool, click on the row corresponding
to the group you wish to capture next.

2. Click Go Capture.
The instrument will place a cap and display the Cap
Properties window for the cap.

3. Enter any information in the window and click OK.

4. 'The instrument will proceed to cut and capture the items in
this capture group.

5. Inspect the captured material, as described previously on
page 25.

6. Repeat for each capture group.
Extracting Captured Tissue from the Caps

Extraction Kits Available from Arcturus

Arcturus  offers the PicoPure™ RNA Isolation Kit (cat#
KIT0202) and the DNA Extraction Kit (cat.# KIT0103)
specifically designed to work with the CapSure™ LCM Sample
Preparation System. These kits provide detailed step-by-step
protocols for extracting DNA and RNA from frozen cells. The
Paradise™ Reagent System, also from Arcturus, is designed
specifically for extracting DNA or RNA from formalin-fixed
paraffin-embedded tissue.
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Extracting from CapSure HS Caps

Following LLCM, place the ExtracSure Extraction Devices onto the
CapSure HS Caps containing the microdissected cells. The
ExtracSure Device seals around the perimeter of the cap surface
and covers the circular ridge that was in contact with the sample
during LCM. With the ExtracSure Device you can incubate the

captured cells in a small volume of extraction buffer. -
NOTE: Due to the way the ExtracSure device fits onto the t LCapture HS Cap
CapSure HS Cap, LCM captures should be made in the center of ExtracSure Device  sealed with
o< e e ; ExtracSure
the CapSure HS Cap, within the black capture ring. Capture HS Cap
Detailed steps are listed below.
1. Use clean tweezers to remove the cap from the cap insertion
tool and place the cap with the sample facing up into the
Alignment Tray. Make sure the cap is properly seated in the
Alignment Tray following the directions in the CapSure HS
manual.
2. Use clean tweezers to remove and position the FExtracSure
Device over the cap. The fill port on the ExtracSure Device
should be facing up.
3. Use tweezers to firmly push down the ExtracSure Device
onto the cap. The ExtracSure Device should fit securely into
place.
At this point, the ExtracSure Device should be firmly sealed
to the CapSure HS Cap.
4. You may add extraction buffer to the device. Do not remove
the assembled ExtracSure/CapSure HS Device from the
alighment try until incubation is completed.
5. After adding the buffer, place a 0.5 mL. microcentrifuge tube
over the fill port and allow the samples to incubate as
described in the appropriate extraction procedure.
Extracting from CapSure Macro Caps R _
Following LCM, you can place CapSure Macro Caps directly onto 2
a 0.5 ml. microcentrifuge tube containing extraction buffer. For ‘
best results, Arcturus recommends the use of MicroAmp®
Autoclaved Thin-Walled Reaction tubes, available from Applied
Biosystems (part number N8010611).
1. Place at least 40 ul. of extraction buffer into a 0.5 ml.
microcentrifuge tube, or if using a PicoPure™ RNA Isolation
Kit or the DNA Extraction Kit, follow the instructions in the
user’s guide.
NOTE: Less than 40 pl. of buffer may not provide enough
volume to cover the surface of the CapSure Macro Cap.
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Use the CapSure Insertion Tool to insert the CapSure Macro
Cap into the microcentrifuge tube.

Press down firmly and rotate the insertion tool to ensure the
Macro Cap 1s tightly and evenly sealed with the
microcentrifuge tube.

Invert the tube so that all the extraction buffer comes in
contact with the captured cells on the cap surface.

Incubate the sample as described in the appropriate
extraction procedure, then place the tube into a
microcentrifuge and briefly spin to bring the buffer to the
bottom of the tube.
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System Overview

3. System Overview

This section gives you a brief description of the Veritas™
application. Also included are user and study information, as well
as descriptions of the key components of the system — caps and
slides, and the images created for each.

Shutdown
1. When you have finished the microdissection session, you can: (ol x|
* Choose Log Out from the User menu. This will allow a e Sl FOrnot BN
R Cap Interaction History =]
new user to log on and start a new session.
* Choose Exit from the File menu. This will close the [Mhszitlaps
application. i
1‘(‘(
Whether you choose Log Out or Exit, the instrument Generated at: 05/21/04 18:02:15
automatically moves the active cap to the unload tray, opens
the instrument door and slides the work surface out. s
The Cap Interaction History appears, opened in Notepad, A
where you may save it or print it. This file shows the location Lowis
of cach cap in the unload tray. For cach cap, the cap name, Unload Tray Fos: 1
. . Cap Name: CAP #3
total area captured and its location are also shown. ggg s bR
NOTE: If you did not place a cap, the Cap Interaction
HiStOIy is not shown. captured from the following slides:
slide nMame: slide #6 slide Type: MEMBRANE
s1ide Mote:
Total Captured Area (micron®¥2): 0.000000
ki ol 2

2. Close Notepad, saving the history if desired. The unload Xl
matertals message appears. ! "-\ After Unloading materials, Press CF to Close the Door

3. Remove all materials from the work surface and then click

. 0K
OK in the message. ok |

The work surface will slide back in and the instrument door

will close.

The application automatically saves all images generated this
session.

If you sclected Log Out, the application will open the
System Login dialog so another user may log in.
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Application Window

When you log in to start a new session and enter the appropriate
information in the Material Loading window, the application
window appears. The Veritas™ application allows you to control
the entire microdissection procedure using the menus, tools and
toolbars in the application window.

HVeritas

File Wiew Tools Image Instrument Materials User ‘Window Help

£ = =l [ = Bl || cl=lalzls]el=]2]]

" Enable BT

- Fire Gettings— - Laser Focus—
fFire: Fine Control
0
5% Fire Limit
IU[no lirniit)
Fower
I?D i
Fulse
|2EDD psec
$ Hits
1
Delas Caarse Contral
0 msec Feset
Irtersity
IZUU my Fes Defaulis
Set Spot Size |

Cutting Laser x|

Pulse
Spaot 2.0pm

Restors
Defaults

@
Offload @
ac ||@
OO
olole;
wlele

Active Slide

Open Door ISIlde H368
MNew Session IDuugiB ~| Properties |

.
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gl LT
e AT 4
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Light Intensil
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if-
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) s

o 2] xa

Capture Image |

Adjust Camera |
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‘ Fed Gleenl Elue LIsarI Hone Shutter ‘

Slide #349

slide #350
Slide #351
Slide #352
Slide #353
Slide #354
slide #364
Slide #3565
Slide #366
Slide #3867
[C1 Images

‘- [B #0 roadmap Image for ©
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(1 Images

_I|=!T #0 Roadmap Image FOLS'LI
4 ] b

B3 Study Data

EN
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B

Cut and Captus | LCM | Ablate |

2« ol

j ﬁ Autoscan

=l
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aprm
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Figure 3-1. Veritas application window
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Roadmap, Live Video and Static Images

There are three types of images in the Veritas application:

*  Roadmaps
*  The live video image
*  Static images

Once you have finished loading materials, the system acquires a
roadmap image for each slide and displays the roadmap and the
live video window. A roadmap is a high-resolution scanned image
of the slide. A roadmap provides a full working view of the slide
and allows you to navigate around the slide. Caps may be centered
on any position within the area defined by the red dotted rectangle.

The region of the slide shown in the live video corresponds to the
area of the roadmap outlined by the red view indicator, a red
rectangle. When the microscope stage in the instrument moves,
the live video updates to show the tissue in the new location.

A static image is an image created from the live video image to
reflect a particular point in time. It does not update when the stage
is moved.

See “Working with Images” on page 43 for more information
about working with each type of image.

Making Software Selections

There are several ways to make selections and access information
within the application:

*  You can right-click to open a context menu.
Right-click on a window, the application background or a
selection 1n a window and choose the menu item of choice.

*  You can drag and drop.
For instance, you may drag and drop caps to and from slides
in the Materials Tool, or Al/T-click and drag the red view
indicator in the roadmap or the live video window to display
a different area of the slide.

*  You can choose options from pull-down menus.
Use the menu bar at the top of the application window to
make sclections. For descriptions of items found in the
menu bar, refer to “Software Menus” on page 63.

*  You can click buttons, check boxes and radio buttons and/
or click and drag other software controls.
Dialog boxes and tools have buttons and other software
controls, such as check boxes, radio buttons and sliders.

B #0 Roadmap Image for Shide #2211

.:.’ asnaan
| o
Red dotted line defines area J “—Red view indicator
where center of cap may be defines area displayed in

placed live video window
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System Users

The Veritas™ Microdissection Instrument allows two types of
users to access the application: users and administrators.

Users can create and access their own study data. Users may also
change their own passwords.

Administrators can create and access their own study data.
Additionally, administrators can add users, delete users and edit
user properties.

When you first log onto the system, you can log in using
administrator as the default user name with no password. As an
administrator you can then add your own user name and password
and assign yourself administrator access, then add other users.
Administrators cannot access study data of other users.

Logging In
All study-related menu options are enabled when you log in. The

System Login dialog box appears automatically when you start the
application or when you log out.

To log in, enter your user name and password, then do one of the

following:
* Click OK

*  Click New Session to display the Material Loading window
and begin the session.

Logging Out

To log out, choose Log Out from the User menu. The application
will open the instrument door, slide the work surface out and
remind you to unload the instrument. Finally, the System Login
dialog box appears, allowing another user to log in.

Managing System Users

You must be an administrator to manage (add, edit, or delete) a
system user.

1. Choose User Manager from the User menu.
The User Manager window appears with a list of all users

Uzer Mame:

Pazsword:

Mew Session I

Lancel

Usemname

| Pazsward

| Access Level

currently in the system. Scroll through the list to see all users. S et
You may sort the list by clicking a column heading. E " e
George arctur Administrator
{hdd ser Delete Lser Edit Uszer E it
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2. ‘lToadd, edit, or delete a user, do the following:

* To add a user, click Add User. The Add User dialog box
appears. Enter a user name and password. Assign an access
level: User or Administrator. Copy user preferences from
an existing user or select the default preferences. (See
page 36 for information on user preferences.) Click OK to
save the changes.

* To delete a wuser, sclect the user from the User Manager list
and click Delete User.

* To edit wser information, sclect the user from the User
Manager list and click Edit User. The Edit User Properties
dialog box appears. Make the appropriate changes to the
user information. You may change the user name,
password and/or access level. Click OK to save the
changes.

3. Click Exit to save the changes and close the User Manager

window.

Changing Your Password

All users can change their own passwords.

1. Choose Change Password from the User menu.
The Change Password dialog box appears.

2. Enter your new password, then enter it again to verify it.
The application assumes that the person logged in is the
person changing the password.

3. Click OK

Add User

Username: I\

Password: I

AccessLevel & User  Adrministrator
Copy Preferences From: IDefauIt j
oK I Cancel |

Edit User Properties

Usermame: IAdministlator

Password: I
Acoess Level  User o Administrator

Cancel

Change Password =l

Mew Pazsword: I
Werify Mew Password: I

Cancel |
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Setting User Preferences

The User Preferences dialog allows you to sct the study parameters

to settings you frequently use. The first time you log in, the user

preferences default to the settings the administrator selected for
you when you were added to the system.

Some options do not apply to all instrument models. Options
which do not apply to your instrument are disabled (shown in gray)
and cannot be selected.

1.

2.

Select Preferences from the User menu.

Enter the necessary information and change the default
values according to your study needs.

You may set unique preferences for each study you perform.
You may also change these settings during your LCM
session.

Root Study Name — If this is your first study, enter a root
study name. All subsequent study sessions that are created
will be contained within the root study. You may change this
name at any time in the future by entering a new name.

Default Filter Selection — If you typically view samples
using white light, select Open (no filter). If you typically
view fluorescent samples, select the appropriate filter as the
default.

Default Capture Mode — Choose between Manual Mode
and Assisted Mode (Assisted Mode is the same as Semi-

Automatic Mode). Arcturus recommends leaving Manual
Mode as the default.

Use Visualizer — The visualizer is a diffuser that can be
placed above the sample to increase the resolution and
decrease the contrast of the live video image. When this is
checked, the visualizer is on. The visualizer and the capture
laser do not operate simultancously. When you enable the
capture laser, the visualizer is automatically removed from the
light path.

Auto-acquire Roadmap Images — Choose this setting to
automatically acquire a roadmap image for every slide you
add to a study. Each slide is scanned for the roadmap image
when you click OK in the Material Loading window at the
start of a session.

Auto Cap Placement — Sclecting this option tells the
system to automatically move a cap to pick up areas targeted
for capture that are outside the area under the current cap
placement, or that are under portions of the cap that have
already been used for capture. If this option is not selected,
the system will not reposition the cap so regions outside the
capture arca of the cap will not be collected.

User Preferences

Root Study Mame:

Default Filker Selection: ID pen - I
IManuaI Mode 'I

[~ Auta Cap Move

¥ Auto Focus
¥ Uze Material Detection

¥ Use Barcode Detection
¥ #wto Brightness Adjust

Default Capture Mode:

[~ Usze‘fisualizer

¥ Auto-acquire Roadmap Images
[~ Auta Cap Placemant

[ Auta Save Default

|V Laser Tool shaws Fire Counter
¥ Auto Locate LCM Laser

¥ Show Y Laser Position

o]

Cancel |
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Auto Save Default — Choose this option to automatically
save the current values for the Laser and Microscope Tools
as the defaults for your next session. If you choose to do
this, the settings will overwrite the current defaults. See
“Customizing Settings for the Laser and Microscope Tools”
on page 85 for more information.

NOTE: If you are using the SystemDefault settings and you
are not an administrator, an error message will notify you
that the settings cannot be saved.

Laser Tool shows Fire Counter — Select this option to
have the Capture Laser Tools display the number of times
the laser will fire to capture all selected regions of interest. If
this is not checked, the system will display the total area of
the regions selected.

Auto Locate LCM Laser — When this is checked, the
instrument automatically locates the capture laser without
requiring any user intervention. If the instrument can’t locate
the laser, the application displays a dialog box informing you
that you must locate it manually. Locating the capture laser is
described on page 50.

Show UV Laser Position — When this is checked, the
instrument automatically displays the location of the cutting
laser in the live video window. The position is shown as a
green circular outline. If you do not have a cutting laser in
your instrument (Veritas™ Microdissection Instrument
Models 701 and 702 and the AutoPix 100c¢), this option is
disabled.

Auto Cap Move — If you wish to have the cap automatically
moved from the active slide after capturing selected cells,
check this option and select either QC or Unload as the
location where the cap will be placed. Typically, Arcturus
does not recommend using this option.

Auto Focus — When this is checked, the instrument will
automatically attempt to focus the microscope for each
objective, the first time you choose the objective for a slide
in a given session.

Use Material Detection — When this is checked, the
application automatically detects the number and types of
slides and caps when they are loaded (the Materials Loading
window does not appear at the beginning of a session). If
you need to change the properties of a detected slide or cap,
right-click and choose Properties. This option is disabled
for the AutoPix 100e.

Use Barcode Detection — When this is checked, the
application automatically detects a barcode on a slide, if
present. The barcode becomes the name of the slide in the
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Materials Tool. If a slide with the same barcode has already
been read, the slide name will be appended with a number.

Auto Brightness Adjust — When this is checked, the
application automatically adjusts the brightness of the image
by changing the shutter speed and lamp intensity until the
brightness is optimized.

Study Information

A study contains all of the information entered for the slide and
cap properties, as well as the corresponding images. You can only
sce the study data that you created, irrespective of your user type.
The name of the study at the top level is entered in the Root Study
Name in the User Preferences.

The Study Tool window allows you to see study data and access
slides, caps and images.

. To open and view an image (roadmap or static), right-click the
image and select View or simply double-click the image
icon.

»  To delete an image, right-click the image and select Delete.

o To view the properties of a slide, cap or image, right-click the item
and select Properties. Properties include names and notes
pertaining to the slide, cap or image.

There are other functions available for items in the Study Tool

window:

*  You can move a slide from one study to another; see
“Moving a Slide to Another Study” on page 87.

. You can copy a slide from one study to another; see
“Copying a Slide to Another Study” on page 87.

*  You can archive data from a study for safckeeping; sce
“Archiving Study Data” on page 88.

. You can also restore archived data to a study; see “Restoring
Archived Study Data” on page 88.

*  You can rename a study or any item contained in a study; see
“T'he Study Tool” on page 87.

(reating a Study

When you create a study you are the owner of that study. Only you
can access the data.

1. Choose New Study from the File menu.
The Create a new Study dialog box appears.

2. Eanter a name for the study.

3. Click OK

Study Tool

=+ Studies
B[ Studyt
B3 Study3
B3 Slide #17
EI[:l Images
“-[B]' #0 Roadmap Image for Slide 17
=3 Slide #2
E|Ci Images
(Y 41 F oacimap Imane: for Slide 82
----- ' #14 Roadmap Image for Slide #2
- CAP:

B Study Data

Study Mame: I

Ok I Cancel
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NOTE: You can also create a study at the beginning of a
microdissection session by entering a new study name in the
Material Loading window.

Slides

Adding a Slide to a Study

The Material Loading window appears at the beginning of each
session. Click the Slide tab to enter information about the current
slide. You can enter a name for the slide, select the study you wish
to assign the slide to and enter any notes about the slide. You can
also indicate the type of slide and whether it 1s a frame slide.

For more information on using the Material Loading window,

refer to “Entering Information in the Materials Loading Window”
on page 67.

Using a Slide from a Previous Study

If you would like to work with a slide from a previous study, click
Existing Slide. A dialog box appears allowing you to select the
study. Click OK after selecting the study.

When you use a slide from an existing study, the existing roadmap
will be replaced with a new roadmap only if you save the slide to
the same study. You can use the Study Tool to access any image in
the study to which the image was saved.

Activating a Slide

Activating a slide moves it over the objective so the camera can
capture a live video image. The roadmap for the activated slide
moves to the front and the active slide is outlined in red in the
Materials Tool.

To activate a slide, do one of the following:

. Choose Activate Slide from the Materials menu, then select
1,2 o0r3.

. Double-click on the slide in the Materials Tool

*  Right-click it and choose Activate Slide.

. Click Slot X in the Materials Tool, where “X” corresponds
to the slide of interest.

Material Loading x|

Caps  Sice | Side 2| Sice 3]

Slide Name and Notes | Slide Image List | Slide Cap List |

V' Loaded
Mame: [Slide #231
Mates: [ Membrane Slide IV Framed
[
Add to Study : IDougie vl

Existing Slide |
ok I Cancel Lpply | Help |

Locate previous slide data E3

- Studies -
- Dave

- Slide #1443

- Slide #1444

- Slide #1445

- Slide #1445

- Slide #1447

- Slide #1448 |

Slide Mame: ISIide #1447

Add To Study:

Cahicel |
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Slide Properties

The Slide Properties window contains information about the active
slide. If you are not using automatic materials detection, this is the
same information you entered in the Slide tabs of the Material
Loading window when you started the session.

. To access this window, select Active Slide Properties from the
Materials menu.
—or—
Right-click on a slide in the Materials Tool and sclect Slide
Properties.

. To see a list of all images that have been saved with the selected slide,
click the Slide Image List tab.

o To see a list of all caps associated with the selected slide, click the
Slide Cap List tab.

*  To make any changes to the skide properties, make the changes and
click OK to dismiss the window.

x
Slide Name and Notes | Side Image List | Side Cap List|
¥ Loaded
M ame: &
Motes: [ Membrane Slide ¥ Framed
E
Add ta Study : IDougie vl
ak. I Cancel | Appli | Help |
Slide Properties x|
Slide Mame and Mates  Shide Image List | Slide Cap List |
Mame | Storage | Created | Madified I
[ #0 Foadmap |..  On Disk 08/47/02  08A7/02
Ok I Cancel | Lpply | Help |
Slide Properties x|

Slide Mame and Motes I Slide Image List  Slide Cap List |

CAP Mame CAPID
CAP #1519

Ok I Cancel Lpply Help
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Caps

Keep in mind the following rules when moving caps during a

session:

*  You can only have one active cap at a time. The active cap
has a red circle in the Materials Tool.

*  You can only place a cap such that the cap’ center is within
the region defined by the dotted red line on the roadmap.

* Auto Cap Placement, which is activated in the User
Preferences (sec page 30), is deactivated for the cap if the
cap 1s moved to the QC station then placed back on a slide.

Placing a Cap on a Slide

The Go Capture tool in the Microdissection Tools automatically Materials x|

places a cap as the first step in the cut and capture process.
Membrane Slide: ¥

"To manually place a cap on a slide, do one of the following:

*  Right-click the live video and choose Place Cap at Region Offload @
Center. ac | |@
*  In the Materials Tool, right-click the active cap and choose OO0 ||
Move To, then select Slot 1, 2 or 3. i
e . OO0 -
* In the Materials Tool, click and drag the active cap to the =
slide. The cap cannot be placed outside the rectangle defined OO0 a %

e ik
Slot2 | Slot3 |

Active Slide:

menu.
Open Door | |amEnzze

The cap will be placed on the slide at the location of the live video

image. The Capture Laser Tools are automatically displayed when New SBSSi"“l IDUU!]iE "I Pmpe'ﬁesl

a cap 1s placed (unless the tools were previously closed).

by the red dotted line. ;
slot 1

*  Choose Place Cap at Region Center from the Materials

The Cap Properties window appears where you can enter
information about the cap (see “Cap Properties” on page 43).
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Moving a Cap to the QC Station

To move the cap to the QC station after capture is complete, do
one of the following:

*  Right-click the live video and choose Move To, then select
QC.

. In the Materials Tool, right-click the cap on the active slide
and choose Move To, then select QC.

*  In the Materials Tool, click and drag the cap from the slide
to the QC station.

*  Choose Move Cap To from the Materials menu, then select
QC.

When the cap has been moved to the QC station, the application
will display the cap in the live video window, where you may
inspect the captured tissue and, if you have a cutting laser (Models
703 and 704), ablate undesired tissue from the cap.

Moving the Cap to the Unload Tray

You can move the cap from the QC station or from the active slide
to the unload tray.

To move a cap to the unload tray, do one of the following:

*  If the cap is on the active slide or in the QC station, right-
click the live video and choose Move To, then select
Unload.

. In the Materials Tool, right-click the cap on the active slide
or QC station and choose Move To, then select Unload.

*  In the Materials Tool, click and drag the cap from the slide
or QC station to the unload tray.

*  Choose Move Cap To from the Materials menu, then select
Unload.

If a cap is left on a slide or in the QC station when you log out or
exit the application, the instrument will automatically move the cap
to the unload tray.

Materials x|

|Memhrane Slide: I v ‘

Offload

@

2| PR
Slot2 | Slot3 |
Active Slide:

Open Door | ||
New Sessionl IDuugie vl Pmpeniesl

Slot 1 |

Materials x|

Offload @

ac | |@
QO || ,
OO0
@O0 e

-1 3
Slot 2 | Slot 3 |

Active Slide:

Open Door | ISIide#228
New SBSSiﬂﬂl |Duugie vl Prupertiesl

Slot 1
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Cap Supply Properties

The Cap Supply Properties window contains information about
the loaded cap cassettes.

To access this window, right-click on the Materials Tool and select
Cap Supply Properties.

If any information is incorrect, you may change it. Click OK to
make the changes.

(ap Properties

The Cap Properties window contains information about the
selected cap.

To access this window, choose Active Cap Properties from the
Materials menu, or right-click on any cap and select Cap
Properties.

In addition to displaying the name and any notes entered when the
cap was placed on the slide, the Cap Properties window displays
the total areca and total number of laser fires for all regions
captured on a cap.

You may rename the cap by editing the Cap Name ficld.

Working with Images

The Roadmap Image

A roadmap is a series of tiled static images that the system creates
after scanning a slide. A roadmap provides a full working view of
the slide and allows you to sclect an region of interest from which
to capture. A roadmap image is created for each slide in the current
session.

If you sclected an existing slide from a previous study, the new
roadmap acquired for the current session will overwrite the
roadmap image from the previous study. Any images saved for the
existing slide will be saved to the previous study. If you acquire a
roadmap image that is not optimal, you can adjust the light
mntensity and reacquire the image. The last roadmap image acquired
will be saved.
. To automatically acquire a roadmap for each new slide, choose
Auto-acquire Roadmap Images in your user preferences,
as described on page 36.

cop supply Properties S zn
Capz I
¥ Supply 1 Loaded V' Supply 2 Loaded
[# Fositicr | V' Position &
¥ Pasition 2 ¥ Pasition &
¥ Pasition 3 ¥ Pasition 7
¥ Position 4 ¥ Position 8
& CapSure HS (* CapSure HS
" CapSure Macio " CapSure Maco
Total Caps: 8
Available Caps: 7
0k I Cancel | Appli | Help |
Cap Properties x|
Cap Data |
CaplD: 229 Cap Type: Macro
Cap Motes:
’7|D.DD i ’7 | 1]
Ok I Cancel | Appli Help

M #0 Roadmap Image for Slide #221 =101%|
2 -—
L rn . ;l’;

]

Red dotted line defines area
where center of cap may be
placed

“—Red view indicator

defines area displayed in

live video window
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. To manually acquire a roadmap tmage, right-click on the slide in
the Materials Tool and select Acquire Roadmap Image.
—ofr —

Activate the slide and choose Reacquire Roadmap Image
from the Image menu.

*  To z00m in on a roadmap, right-click the roadmap and choose
Zoom, then select the desired zoom setting;

Click on the roadmap image to make it active and sclect
Zoom from the Image menu.

The Live Video Image

The live video image displays the area of the slide that corresponds
to the area in the roadmap bounded by the red view indicator, a
red rectangle.

You cannot resize the live video window, but you can minimize it.
You can also close it.

. To reopen the live video window, select Activate Live Video
from the View menu.

. To display a different area of the skde in the live video image, you
must move the stage. You can move the stage from the
roadmap, the live video image or the Materials Tool, as
described below. In all cases, the red view indicators in the
roadmap and the Materials Tool move as needed to indicate
the area in the live video.

NOTE: The red view indicators on the roadmap and the

Materials Tool only approximate the area shown in the live
video.

o To goom in on the live video, right-click the live video and
choose Zoom, then select the desired zoom setting,

— Or —

Click on the live video window to make it active and select
Zoom from the Image menu.

Moving the Stage from the Live V'ideo Window

There are several methods to move the stage to display a new
region of the slide in the live video window. (The actual movement
will vary based on the objective currently in use.)

To move the stage from the live video image window, do one of

the following:

. By default, when the live video window is active, the cursor
changes to a hand. Click and drag to move the stage.

. Press the UP, DOWN, LEFT and RIGHT arrow keys to move
the stage.

. Hold down the CONTROL key while pressing an arrow key to
move one half of the field of view at a time.
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*  Use the Navigation tool, as described on page 80.

Moving the Stage from the Roadmap Window or the Materials Tool

You can also move the stage from the roadmap or the Materials
Tool and thus update the live video. As before, the red view
indicators in move as needed to indicate the current area shown in
the live video.

To move the stage from the roadmap window or the Materials

Tool, do one of the following:

*  Double-click on the position of interest.

*  ALT-click on the red view indicator to select it, and then drag
it to a new area of the slide.

. Press the Up, DOWN, LEFT and RIGHT arrow keys to move
the stage.

. Hold down the CONTROL. key while pressing an arrow key to
move one half of the field of view at a time.

Static Images

R RS

A static image is a picture of the live video image at the current

magnification. You can mark the areas of interest that you wish to
capture on a static image. You can also use static images to create a
training file for the Auto Scan feature.

Acquiring a Static Image

There are several ways of acquiring a static image:

* o acquire a static image that shows the same area as the live video
image, right-click the live video and select Acquire Static
Image.

— Or —

Select Acquire this Region as New Image from the Image

menu.
— Of —

Click the Capture Image button in the Microscope Tools.

*  To acquire a static image for a region of any sige, zoom in on the
roadmap as necessary, sclect the Region of Interest tool
from the Static Annotations Toolbar, and then click and
drag to draw a rectangle on the roadmap. Double-click to
turn off the Region of Interest tool, then right-click the
region and sclect Acquire Region.

The system creates a series of tiled images. The advantage of
a tiled image is that you have a much larger area from which
to capture.

Acquiring a static image using the Region of Interest drawing tool.

NOTE: The size of the region you can draw is limited by the
computer’s memory. The larger the region, the more
memory required to generate a static image. Additionally, for
a specific selected area, the higher the magnification (i.e. the
larger the objective), the more memory required to generate
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an image. If you have trouble generating a static image due
to memory limitations, either reduce the size of the area you
arc drawing or use a lower magnification.

To acquire a static image that covers the area of the entire cap, right-
click the live video and select Acquire Static Image of full
Cap Area. The system creates a series of tiled images
representing the area within the cap. This option is only
available at 2x.
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Image Properties

The Image Properties window contains information about the
image, including the source of the image, the date it was created
and the microscope settings that were used when the image was
saved.

1. To open the Image Propertiecs window, choose Image

Properties from the Image menu. Name: [ Roadmap Image for Side 3

— Or — Motes:

Right-click the image in the Study Tool and select
Properties.

2. You can change the name of the image and enter notes.
Image Size: 2260 = 762

Dizplay Image |

3. Click Display Image to view the image. Image Source: 1 Roadmap Image for

Creation Date:  Friday, August 09, 2002
4. Click OKto close the window and save your changes. el vty g 09, ST

Microscope Setting

Maanification: 0% Light Intensity : 100 Camera:
SaVing an Image ’7“"9” “Wisualizer : aff Shutter:  Cloze

The application automatically saves any images generated this

T Cancel

session. You can also manually save any image. Images are saved as

JPEGS to the study directory. Images include:

*  roadmap image of a slide

*  static image of the live video image

* aseries of tiled images of an area larger than the live video
image

*  static image of cap in the QC station, after cells are captured

NOTE: If you wish to save the image to a separate storage device

for your own use, export the image (see “Exporting an Image” on

page 48).

To manually save an image:

1. Activate an image window.

2. Choose Save Image from the Image menu.
The Image Properties window appears.

3. Enter a name for the image and notes, if you wish.

4. C(lick OK

Opening an Image

You can open and view any image after a study. Images are

accessible from the Study Tool in one of the following ways:

*  Locate and double-click the image in the Study Tool.

*  Right-click it and select View:

e If the Image Properties window is open, click Display
Image.
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Exporting an Image

Any annotations are exported along with the image. Images can be

exported in the following file formats.

TIFL (*.tif)

JPEG (“jpg)

PNG (*.png)

Windows bitmap (*.bmp)

Choose Export Image from the Image menu.
A standard Save As dialog box appears.

Choose the location where you wish to save the file.

Enter a file name and select the file type to save.

Click Save.

Deleting an Image

Saveas 21|
Save in: Ia sCreens j & I‘j‘ =
File name:  [#1 Static Image: for Slide #44 Save I
Save as type: | Tif [+ 1] = Cancel |
v

1. Locate the image in the Study Tool.
2. Right-click the image and select Delete.
The image and its associated files are deleted.
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4, Additional Procedures for Microdissection

Working with the Capture Laser

Manually Focusing the Capture Laser Beam

The Veritas™ Microdissection Instrument incorporates an

automatic focus lock for the capture laser beam. In most cases, this

Capture Laser #|

will be sufficient in order to maintain proper focus. If not, you may [# Enable Matrx_|
manually focus the capture laser as described below. _ Bl Sl Lo e —
1. Focus the capture laser beam. Fire | Fine Cantral
* Ensure Enable is selected in the Capture Laser Tools. IU z
* Enter Power, Pulse, # Hits, Delay and Intensity. The bz Fire Limit
default settings may be sufficient for starting out. ID[”':' it
. . Pawer —_"
* Move the beam to an area where there is no tissue or the 0 v :
tissuc is very thin and light. If you are using a CapSure HS Pulse :
Cap, move to an area outside the black circle. 2500 paec =
* Focus the beam by adjusting the coarse and fine settings. it Hitz il il
The beam spot should be a discrete point. The halo around 1
the spot should be as close as possible to the focused D elay Coarse Contro
centroid point of the laser. 0 msec _ Reset |
Intenzity
- |2EIEI i Fes. Defaults I
@/ Set Set Spot Size |
Unfocused beam Focused beam Unfocused beam Laser has NOT been located! I
NOTE: If you are having trouble secing the beam, decrease
the lamp intensity using the Light Intensity slider in the
Microscope Tools. If the laser is difficult to see even at low
light intensity, reduce the camera shutter speed to 1/50. See
“Camera Control Dialog” on page 68 for instructions on
setting the shutter speed.
* Click Set to apply the changes.
For detailed information on using the Capture Laser Tools
and recommended settings, refer to “T'he Capture Laser
Tools” on page 76.
2. Locate the capture laser beam.
When Auto Locate LCM Laser is selected in your User
Preferences, the system automatically locates the capture
laser. Locating the laser beam establishes a connection
between the cursor and the laser beam so that when you
click to fire or target the beam, the laser accurately fires on
the cells you have selected.
When the capture laser has been captured, the button in the
Capture Laser Tools says “Laser has been located” in blue
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text and the live video window will show a blue + at the
laser’s location.

You may also locate the laser manually; see “Manually
Locating the Capture Laser” on page 50.

Manually Locating the Capture Laser

The Veritas™  Microdissection Instrument will normally
automatically locate the capture laser for you. If not, you may assist
the instrument by moving the stage so that a clear spot appears in
the center of the live video window and then clicking the button in
the Microscope Tool which corresponds to the current objective.
The instrument will attempt to locate the capture laser. If it fails to
do so (the button at the bottom of the Capture Laser Tools says
“Laser has NO'T been located”), you may manually locate the
capture laser as described below.

In the live video, place the point of the cursor directly at the center
of the laser spot. Then, right-click and sclect CAPTURE Laser Is
Here.

NOTE: It may be helpful to zoom in on the image —right-click on
the image and choose a zoom setting — to more accurately mark
the laser location.

When the capture laser has been captured, the button in the
Capture Laser Tools says “Laser has been located” in blue text and
the live video window will show a blue + at the laser’s location.

Test Firing the Capture Laser

Wetting refers to melting the polymer on the cap so that it fuses
adequately to the tissue or cells when the laser fires. Perform this
step each time a new cap 1s placed on a slide.

Until you can confidently recognize proper wetting on tissue, fire
on an area outside the tissue where you can see a clear outline.

1. Click Fire in the Capture Laser Tools to fire the laser. Move
the cursor away from the area to examine the wetted spot.
When the film is visible as a dark ring fused to the slide and
the center of the ring is clear, the wetting is adequate.

2. If wetting is not adequate, adjust the laser parameters. The — : - -
CapSure Macro Cap CapSure HS Cap

laser Power and Pulse settings affect the size of the wetted

spot. (For information on adjusting the spot size, refer to

“Optimizing the Capture Laser Spot Size” on page 77.)
NOTE: You may also set the laser parameters using a calibration
matrix; see “Using a Calibration Matrix to Determine Capture
Laser Settings” on page 78.
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Manually Measuring the Capture Laser Spot Size

The application uses the spot size to control the movement of the
stage during capture and to calculate the area of tissue that will be
captured.

1. To measure the laser spot size, click the Set Spot Size button
located in the Capture Laser Tools. The Laser Spot Size
Measurement dialog box appears.

2. Measure the diameter of the center of the laser spot by
clicking on one side of the spot, then clicking on the opposite
side.

* The application calculates the diameter of the spot and
displays the value.

* Click OK. The spot size value replaces the word “Small” in
the Capture Laser Tools.

NOTE: The measured spot size applies only to the current
laser parameters. If you change the parameters, you must
remeasure the laser spot size.

Working with the Live Video Image

Manually Focusing the Live Video

If you have Auto Focus sclected in your User Preferences, the
system automatically focuses the live video image. Likewise, if you
have Auto Brightness Adjust sclected, the system automatically
sets the image brightness.

The Veritas™ Microdissection Instrument is calibrated so the
objectives are parfocal. If you focus at 40x or 60x and then change
the objective, the image should remain in focus.

NOTE: You must focus at the highest objective (either 40x or
60x) to take advantage of the parfocality. The depth of field for
the 40x (or 60x) object 1s narrower than for the lower power
objectives.

If the live video is not in focus once the auto-focus completes,
change the light intensity and click AUTO in the Objective Focus
section of the Microscope Tools. The software will repeat the
auto-focus procedure.

If needed, you may manually focus the live video image, as follows:

1. On the Instrument menu, choose Filter then None, to open
the filter.

Lazer Spot Size Measurement

Usge the mouse to click on each side of wetting
zpot in live video display to determine the capture

zpot size,
Spot Size: I

Laser Spot Size Measurement

Use the mouse to click on each side of wetting
zpot in live video display to determine the captune

spot size,
Spot Size: I 21 um

x

— Objective — Objective Focus
Fine Coarze

— Light Intenzity ——

¥ Enatle
4_
| I 5 um
|| 2

al |
I
- 75
]
— Stored Positionz

il | B e [ TR

Capture Image I Adjust Camera I Fluorescence I

I Red Greenl Blue I [lzer I Nu:unel Shutter I

2

10

O — =
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2. Seclect the 40x Objective (or 60x if your instrument is so
equipped). Focus using the Coarse Control arrows and the

Fine Control slider.

Check Enable under Light Intensity to turn the lamp on.
Either click AUTO or use the slider to adjust the lamp
intensity.

NOTE: If you are performing fluorescence LCM, turn on the
fluorescence lamp by clicking Fluorescence. Click Shutter
to in the Microscope Tools to expose the sample to
fluorescence excitation. Click Shutter again to block the
excitation light source to avoid photo-bleaching. The light is
blocked when the button appears “not pressed”; the sample
1s exposed to the light when the button appears depressed.
You can change the color of the illumination by selecting a
filter in the Microscope Tools.

If you plan to use another objective later, you may check its
focus now. The instrument’s parfocality should ensure that
the microscope is still in focus after you change the objective.
If not, adjust it as needed.

The application remembers the focus settings for ecach
objective used for a given slide.

For detailed information on using the Microscope Tools, refer to
“T'he Microscope Tools” on page 83.

Microdissection of Fluorescent Samples

This section describes tips for working with fluorescent samples.
In general, the procedures outlined in Chapter 2, “Fasy Access to
Microdissection” on page 17, apply to fluorescent samples.

NOTE: The

instrument is equipped for epi-fluorescence (Models 702 and

Fluorescence button is enabled when your
704). When you click Fluorescence, the fluorescence lamp is
turned on and the controls for the fluorescent filters and shutter

are enabled.

The fluorescence lamp requires several minutes to warm up
in order to reach its maximum intensity. Turn it on by
clicking the Fluorescence button in the Microscope Tools.
When the lamp is ready, “EPI ready” appears in the lower
right corner of the screen.

Once the lamp 1s on, you must click Fluorescence again to
turn it off. If you turn off the fluorescence lamp, it must cool
down sufficiently before the lamp controller will turn it on
again. This may take as long as five minutes. (If you turn the
lamp on before the lamp has cooled, the lamp will not
flluminate until cooling and the subsequent warm-up have
completed.)

x

— Objective — Objective Focus — Light [ntenzity——
2>< Fine Coarse ¥ Enable
s I 1 al |
) ]
10 T -I-/ nem || 7 T 169
] + 0

I 20
B — Stored Positions

| e N T
Capture Image | Adjuzt Camera I( | Fluorezcence }

I Red Greenl Blue I |lzer I Nunel Shutter I

Microscope Tools for EPI fluorescence-equipped systems
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. If you are not viewing the sample, you should close the
shutter to avoid photo-bleaching. To do this, click Shutter,
in the Microscope Tools or uncheck Shutter in the EPI
Filter/Shutter item on the Instrument menu.

. For the AutoPix 100e instrument, you may select a neutral
density filter from the EPI Filter/Shutter item on the
Instrument menu. Filter choices are 100%, 25%, 10% and
1%.

*  To view fluorescent-labeled samples on a dark field, turn off
the white light by unchecking Enable in the Microscope
Tools, then open the shutter by depressing the Shutter
button.

*  You may need to change Integration and/or AGC
(automatic gain control) in the Exposure tab of the Camera
Control dialog if you are having a hard time seecing your
sample. See “Camera Control Dialog” on page 68 for details.

*  Also in the Camera Control dialog, you may need to change
Gamma, located on the Color tab.

* If you regularly work with both fluorescent and non-
fluorescent samples, you should consider creating default
settings for the Laser and Microscope Tools for each type of
work, as described on page 85. You can save time by loading
the appropriate settings file at the beginning of your session
and climinating much of the time needed to set up your
system.

Overview of Additional Microdissection Methods

In addition to the microdissection process described in Chapter 3,
the Veritas™ Microdissection Instrument offers the following
additional modes for capturing cells or tissue:

*  Live Point-and-Shoot Capture of Single Cells — You may
capture cells while viewing the live video image for the slide.
Simply navigate to a cell of interest, then double-click on it
to fire the laser and capture the cell. See below for more
information.

*  Mark and Capture Cells or Regions on a Static Image —
With the Microdissection Tools, you can mark the desired
cells and/or regions on a static image and then the system
will capture each cell or area, until all sclected tissue is
captured.

See page 54 for more information.

*  Auto Scan on a Static Image — Use a representative tissue
slide to “train” the application to recognize cells and areas of
interest and saves the information to a training file. Once a
training file is created, you can use the file again to quickly
scan a similar slide and automatically capture the areas of
interest. See page 55 for more information.
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Live Point-and-Shoot Capture of Single Cells

1.

4.

Prepare your samples, load your slides and caps and focus the
microscope as described in Chapter 2, “Hasy Access to
Microdissection”, on page 17.

Select Manual Capture from the Capture Mode submenu
on the Instrument menu.

NOTE: You can mark images for automatic capture and
perform point-and-shoot capture on the live video in
Manual Capture mode. The Semi-Automatic Capture
option prevents you from performing point-and-shoot
capture on the live video and should only be used if
accidental point-and-shoot firing is a concern.

Double-click on cach cell you wish to capture within the live
video image.

Fach time you double-click on a cell, the capture laser fires
and captures the cell.

"To navigate to other areas, use any of the methods described
in “Moving the Stage from the Live Video Window” on
page 44.

You may check the slide and the contents of the cap to verify
that the capture was successful. Refer to “Inspecting
Captured Material” on page 25.

Mark and Capture Areas on a Static Image

1.

Prepare your samples, load your slides and caps and focus the
microscope as described in Chapter 2, “Easy Access to
Microdissection” on page 17.

Acquire a static image. Right-click on the live video and
choose Acquire Static Image.

—of—

Click the Capture Image button in the Microscope Tools.
—of—

Use the Region of Interest tool from the Drawing Toolbar
to outline a static image of a region from the roadmap, then
right-click and choose Acquire Image. (For more
information on creating a static image, refer to “Acquiring a
Static Image” on page 45.)

Mark the image for selection.

Use the Microdissection Tools to mark cells or regions to
capture. (Refer to page 80 for information on using the
Microdissection Tools.) Stay within the confines of the cap
as you move around the image to mark cells and tissue.
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Any dissection marks you add to the image are also shown

on the roadmap and the Materials Tool (though you may not
see them, depending upon the magnification).

dissection region

dissection region with
exclusion

dissection line

single-cell selection

Figure 4-1. Static image marked up for capture, using the
Microdissection Tools.

4. If desired, use the Drawing Toolbar to add annotations to the
image. (See “The Static Image Annotations Toolbar” on
page 90 for details.)

5. Capture the selected cells by doing one of the following:

* Clicking Go Capture.

* Right-click on the static image away from the selected cells
and choose LCM Capture Selected Cells. This starts the
collection process.

* If you’ve chosen to ablate before capturing, right-click and
chose Cut Selected Cells, then right-click and choose
LCM Capture Selected Cells.

6. You may check the slide and the contents of the cap to verify
that the capture was successful. Refer to “Inspecting
Captured Material” on page 25.

Introduction to Auto Scan on a Static Image

The Auto Scan feature allows you to “train” the system to capture
cells of interest for a particular tissue type. You define the capture
criteria by indicating what areas of the tissue are of interest and
what areas are background.

NOTE: This feature operates ox/y on a static image.

The information is saved to a file, which you can use later on other
slides with the same or similar tissue. You can also combine
multiple files to create a new file. Refer to “Combining Auto Scan
Training Files” on page 61.
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The application provides three levels of training. You can apply as
many levels as is necessary to achieve the most desirable results,

but you must start with and perform at least the Pixel Analysis. For
many samples, Pixel Analysis is sufficient.

Pixel Analysis differentiates regions based on pixel color. It
is best suited for slides that have a high contrast or definite
differences in color between the regions of interest and
background.

Texture Analysis differentiates tissue based on textural and
topological characteristics. It can be used after Pixel Analysis
to further discriminate regions of similar color by analyzing
groups of pixels for differentiating characteristics.
Morphology Analysis differentiates the shape of regions of
interest from targeted background areas.

Microdissection Using Auto Scan

1. Prepare your samples, load your slides and caps and focus the
microscope as described in Chapter 2, “Easy Access to
Microdissection”, on page 17.
NOTE: If you are creating a training file, you can create the
file and scan the slide before placing a cap and locating and
measuring the laser. A default laser spot size of 10 um will be
used until you measure the spot size.
2. Right-click the live video image and select Auto-Scan
Click the Auto-Scan button on the Capture Groups Tool.
The Auto Scan window appears and a static image is autoscan ]
acquircd iﬂ a new WiﬂdO\V. Scan |Fieg\on Listi F'ixe!i-\nalysisl Texture Analyws' fdo 4| »
Select a braining file
~ . Select a Training File or Mew: = Combine
3. Seclect <New> to create a new training file. Gl ¢ . B[R e
Detection P b
—or— ’14:—.3. ROE[D | MasROlAwa@d)[l
Select an existing training file from the drop-down list
If you choose an existing training file, proceed to step 8. to (G e ‘
sclect an area and scan. |
When you create a new file, the Pixel Analysis tab becomes steitz
active, allowing you to define the training criteria. |
NQTE: Do not click the chn button until you have finished ﬁgmgz‘pen som |
training the system. Clicking the Scan button saves the
training file.
NOTE: If you are performing fluorescence imaging, check
Auto Open in the Epi Shutter section of the Auto Scan
dialog box. This will only open the shutter briefly while
performing the scan, to prevent photo-bleaching of the
sample. If you do not check Auto Open, the shutter remains
in the state set in the Microscope Tools.
56  www.arctur.com techsupport@arctur.com 650.962.3020 888.446.7911 Version C



Additional Procedures for Microdissection

4. Click the Pixel Analysis tab.
Use this first level of training to select representative pixels
of regions of interest (ROIs) and representative pixels of
background.

* Click the ROI (Region of Interest) button, then click on
arcas you wish to capture. Sclect samples of ROIs
representative of all color variations in which you are
interested.

Click the Background button, then click on areas of
background. Select samples of background representative
of all color variations you wish to exclude.

The Clear button removes all selected areas of either ROI
or background (depending on which is selected), allowing
you to start the selection process over.

* Enter a value for the Min ROI Area pmz.
This value defines the minimum size for an area to be
considered for analysis by this algorithm. For most
applications, the default value of 100 is suitable.

* Enter a value for the Area of Influence.
This value defines an area of pixels surrounding the point
that you select. This area will be averaged and used by the
algorithm to differentiate ROI from background. The
default value of 3 is suitable for most samples.

* Sclect the Algorithm.
Pixel Learn — a basic algorithm used for standard tissue
using the color camera.
Pixel Learn Advanced — used for tissue with more
complex coloring or intensity variation, where Pixel Learn
does not provide adequate results.
Pixel Detect (gray scale) — an algorithm for black and
white differences.
Pixel DetectS (convex hull) — a fast algorithm for black
and white differences. Useful for scanning large areas on
cytology samples.

* Sclect the Classification.
Uni-Modal — used for samples where there is sharp
contrast between background and ROL If you select Uni-
Modal, you can adjust the stringency of the ROI
selections. A lower stringency favors ROI detection but
increases false positives, while a higher stringency results
in less false positives, at the risk of missing some ROIs
(higher ROI purity).
Multi-Modal — used for samples where the background
has a number of color variations. The classification
number entered indicates the number of color patterns.
The number after the decimal point indicates the level of
accuracy. For example, 2.50 indicates an analysis using a
total of four distinct color patterns—two for ROI and

Scan I Region List  Pisel Analysis |Texture Analysisl oA I 4

Cuirent Training File

x|

||iver

"Pixals Setting far

" ROl [Region of Interest]
b 4
Lol d

rea uné &rea of [nflusnce

Analpsiz Setting

Algorithm Classification
IF'\er Leamn j I Uni-Moclal j
Shingency
Higher Lawer Mode

Learn |

LCancel |
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two for background—with a probability threshold of 0.5.
Decreasing the probability threshold (for example, 0.2)
will favor ROI detection and increase false positives, while
increasing the threshold will result in less false positives, at
the risk of missing some ROIs.

Click Learn.

The application analyzes the area within the image and
marks ROI areas.

The next step in the process depends on your level of
satisfaction:

If you are satisfied with the results, proceed to step 8. to scan
the sclected area.

If you are not satisfied with the results, you can repeat the
selection of ROIs and background to provide the
application with more information. You may also change
the settings within the Pixel Analysis tab to modify the
results.

To refine the selections, you may continue with further
training by proceeding to texture analysis in step 5. and/or
morphology analysis in step 7.

NOTE: Using texture and morphology analysis in addition to
pixel analysis will result in longer sample scanning times.

To train the system for texture analysis, click the Texture

Analysis tab and enter the appropriate information.

Use this second level of training to select areas of ROls and
arcas of background to perform an analysis based on textural
differences.

Click the ROI (Region of Interest) button, then click to
create regions around areas of interest with typical texture
or topology. Double-click to close the region.

Click the Background button, then click to create regions
around areas of background texture or topology not found
in areas of interest. Double-click to close the region.

Enter a value for the Min ROI Area umz.

This value defines the minimum size for an area to be
considered for analysis by this algorithm.

Enter a value for the SubImage Size.

This value defines the number of sections into which the
region areas previously defined are divided. The texture
features are derived from these sub-images.

Select the Classification.

Uni-Modal — used for samples where there is sharp
difference in texture between background and ROL
Multi-Modal — used for samples where the background
has a number of texture variations. The classification
number entered indicates the number of texture patterns.
Click Learn.

Scan | Region L\stl Pixel Analysiz  Texture Analysis |M0 1 I 4

Current Training File

“iVEI 3

 Pizels Setting for
o
" Background

Clear |

Min ROl Area unf

SublmageSize

[128
— Analpsiz Setting

IB

Classification
I Uni-Modal e I

Shingency

x|

LCancel |
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The application analyzes the area within the image, applies
the new information and marks ROI areas.

The next step in the process depends on your level of
satisfaction:

If you are satisfied with the results, proceed to step 8. to scan the
selected area.

If you are not satisfied with the results, repeat the pixel level
analysis. You may also change the settings within the
Texture Analysis tab to modify the results.

To refine the selections, you may continue with further training
by proceeding to morphology analysis in step 7.

To add a final morphology screening, click the Morphology
Analysis tab and enter the appropriate information.

This tab provides a final screen allowing you to verify the
areas to be captured and to eliminate any false-positive areas
that have been selected. Use this level of learning only if you
see background areas that were selected as ROls.

Click ROI, then click to select at least two representative
areas of ROI (a blue outline appears).

If you sce a background area that is selected for capture,
click the background button, then click on at least two
areas to change them to background (a green outline
appears).

Sclect the Classification.

Uni-Modal — used for samples where there is sharp
difference in morphology between background and ROL
Multi-Modal — used for samples where the background
has a number of morphology variations. The classification
number entered indicates the number of morphology
patterns.

Click Learn.

The application analyzes the area within the image, applies
the new information and marks ROI areas.

Pixel Analysisl Testure Analysis  Morphology Analysiz | 1 I 4

Current Training File

X

|T est for Collagen Data

— Select Objects for
& ROl

= Background 100

Min ROl Area (]

— Analysiz Setting:

Classification Chaice
I Uni-Madal A l
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Click the Scan tab and enter the appropriate information.
Once you click the Scan tab, the training is complete and the
file is saved. The file can no longer be edited; however, it can
be overwritten.

Enter the Max ROIs to capture.

This the maximum number of regions to be captured.
Enter the Max ROI Area pmz.

This value defines the maximum size for an area to be
considered for capture.

NOTE: Enter a value of 0 for Max ROI and Max ROI

Area umz to indicate no limits.

Select the area to capture.

Screen scans the area within the live video image. Locate
an area of interest, then scan and capture. Continue
locating arcas and scanning, while staying within the
confines of the cap.

HS Cap scans an arca approximately the size of the
capture area of an CapSure™ HS Cap (3 mm x 3 mm).
This option assumes the current position in live video 1s
the center of the cap. If necessary, the cap will be moved
during the capture process to collect all targeted areas.
Macro Cap scans an arca approximately the size of the
arca of a CapSure Macro Cap (6 mm x 6 mm). This option
assumes the current position in live video is the center of
the cap. If necessary, the instrument will move the cap
during the capture process to collect all targeted areas.
Area scans an arca 20 mm x 20 mm starting from the
region center. To prevent the system from attempting to
place the cap off the edge of the slide, place the live video
in the center of the slide. If necessary, the cap will be
moved during the capture process to collect all targeted
areas. Use only for samples where tissue 1s sparse to avoid
capturing cells onto an area of the cap that already
contains tissuec.

Click Scan.

The application scans the selected area for ROIs using the
information it has learned and creates a list of them in the
Region List tab.

autoscan x|

Scan |F|egi0n Listi Fixel Analysisl Testure Analysisl I A I L4

Select a training file
j Caombine |
Max ROl Area [pre] |0

|<Select a Training File or Mew:

bz F!DISlD :

" Detection Param

’75' Scieen ( HSCap ¢ MacioCap = Area ‘

Static

Epi Shutter
¥ At Open Scan
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[Auto Scan x|

9. After scanning, click the Region List tab and manually select
Scan  Region List |F'ixe| Analysisl Testure Analysisl o A I 4

all of the regions that you wish to capture.

- . Do . . Locati | Frame | 5i | _za
I'he regions appear highlighted in the static image. s 1 P o

- . . 74278 200202 %

* To see a region, double-click the entry in the tab (a green EE43,82] b 01 o

outline appears around the region). Oisas 3875 81

. . , Oie43433 A 1535 5

* To select a region for capture, click to place a check mark in the OErase) 1374 7

: : : Q Olizse184) A 1636 5

box (a blue outline appears around the region). Select Duesse 1 1o7a o

multiple regions by holding down the Stirr key to
highlight the entries. Press the space bar to select them.

* To modify regions on the static image prior to capture, use the
Microdissection Tools. | L 0

Harvest |

10. Click Harvest to capture all the regions with “X” next to
them in the list.
If you havc.not placed a cap, you will be prompted to do. sO. foct |
Drag a cap in the Materials Tool to the active slide and adjust
the laser parameters as described in “Working with the

Capture Laser” on page 49.

You can capture selected areas on the static image by right-
clicking and sclecting LCM Capture Selected Cells from
the menu.

11. You may check the slide and the contents of the cap to verify
that the capture was successful. Refer to “Inspecting
Captured Material” on page 25.

12. For subsequent slides using the same training file, perform
steps 1. and 2., then proceed to step 8. to scan the selected
area.

Combining Auto Scan Training Files

To create a training file that you can use to scan different slides of
the same tissue type, create multiple training files for slides with
different staining intensities, tissue thickness, as well as various
light intensities, then combine the files. The resulting file
incorporates all of the information from each of the files used to
create it.

NOTE: You can combine only files that use the same algorithms.

You cannot edit a training file.

1. Create as many individual training files as you wish. For each
file, you may want to use a different slide of the same tissue

type.

2. When you are ready to combine the files, right-click on the
live video image and select Auto-Scan.
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2=
3. Click Combine to display a list of training files. Lack n: [ TrainingFiles =l + @&k E-
. .o . brain pHp
4. Click to select the training files you want to combine. Hold B

the SHIF'T key to select multiple files.

5. Enter a file name in the New Training File Name field, or
use the default name.

File name: |"Iiver3.pxp" Mliver2. pup" liver pap” Open I
Files of type: ITraining files [*.pxp] ﬂ Cancel |

New Training File Name [Newlvers pxp |

6. Click Open.
The system creates the file and adds it to the Select a
Training File drop-down list in the Auto Scan window.

File Preview
tutiple files zelection not applicable.

7. 'To use the file, select it from the list and click Scan.
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5. Software Menus

This section lists the Veritas™ application menus and provides a
brief description of cach option.

File Menu

New Study — Allows you to create a new study. A study contains
cap and slide properties and any images that are saved during the
session.

Show Daily Activity Report — This will display a report in
Notepad, showing all of the Cap Interaction Histories for the day.
The file is a text file named with the date (YYYY-MM-DD-
Activity.txt) and 1s saved in the

C:\Veritas Images\DailyActivityReports folder.

Load Defaults — Allows you to load a laser and microscope
settings file. The system will initially load the settings file that was
selected in your User Preferences when your account was created.
If your account was not assigned a specific default setting file, the
SystemDefault settings are automatically loaded. See page 36 for
more information on saving other types of settings as your
defaults.

Save Defaults — Allows you to save the current laser and
microscope settings to a file that you can recall and use later for
another session.

Save Defaults As — Allows you to save the current laser and
microscope settings under another name. If you are a user and you
attempt to save changes to the SystemDefaults settings, you will
not be allowed to do so. Instead, you must use the Save Defaults
As option. Only an administrator can change and save the
SystemDefault settings.

Launch File Transfer — This option should only be used when
mstructed to do so by Arcturus service personnel. It is only
accessible by an administrator.

Exit — Logs you out and closes the Veritas™ application. The
application will prompt you to remove and caps and slides from
the instrument and save any images created during the session.

View Menu

Toggle Laser Tool — Sclects what is shown in the Taser Tool.
Choose Area Capture to show the area of targeted regions or Fire
Capture to show the number of laser fires required to cover
targeted regions.

Activate Live Video — Choose this to open the live video window
if it has been closed.

Mew Study, .. Chrl+
Show Daily Activiby Report
Load Defaulks CErlHD

Save Defaulks
Save Defaults As, ..

Launch File Transfer

Exit

Wiew Tools Image Instrument  Materials

Toggle Laser Tool — k

activate Liveyiden ¥

AOrea Capture
Fire Counter
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Tools Menu

The Tools menu allows you to show or hide the tools and toolbars.
A check mark indicates that the toolbar is displayed. To hide the
toolbar, choose the option again to remove the check mark.

You can also display the Tools menu by right-clicking in the
background of the application window:.

Image Menu

The Image menu allows you to work with the current image. You
can use the cutting laser and capture laser as well as zoom in on the
active roadmap or static image.

See “Working with Images” on page 43 for detailed information
on images.

Cut Selected Cells — If one or more regions have been created
using the Cut and Capture Tools and/or the Ablate Tools, this

option will cut the region(s). If you do not have a cutting laser
(Models 701 and 702), this option is not available.

LCM Capture Selected Cells — If you have identified a region or
cells or tissue to capture, this command operates the capture laser
and fuses the tissue to the cap. If a cap has not already been placed,
the system will first place a cap, then capture.

Acquire this Region as New Image — Allows you to reacquire
the current static image without removing any annotations or
dissection marks on the image. Use this if the initial microscope
settings were unsatisfactory and/or the image is not as clear as
youd like.

Reenable — Enables the system so you may repeat any cuts or
captures. (Ordinarily, the Veritas™ Microdissection Instrument
does not allow you to cut or capture any area a second time.) You
can set this option for a single dissection mark, as well, by right-
clicking on the dissection mark and selecting Reenable.

There are three choices for Reenable:

*  Cut All Selected Cells — If you select this, the next time you
choose Cut Selected Cells, any arca marked with one of the
Cut and Capture or Ablation Microdissection tools will be
cut, irrespective of whether it was previously cut.

* LCM Capture All Selected Cells — If you select this, the
next time you choose LCM Capture Selected Cells, any
arca marked to capture will be captured, irrespective of
whether it was previously captured.

Microscope ...

Capkture Laser ...
Cutking Laser ...

Study Toolbar. ..
Mavigation Toalbar ...
Materials Toolbar. ..
Capture Groups ...
Microdissection ...
Font Toolbar ...
annotations Toolbar ...

Showe &l Toolbars. ., Chrl+5
Hide all Toolbars. .. Ckrl+H

Zut Selected Cells
LM Capture Selected Cells
fcquire this Region as Mew Image

Reenable r
Zoarm L4
Save Image. ..

Export Image. ..

Image Propetties. ..

Get Full Cap Area
Reacquire Roadmap Image

adjusk Brightness

Image Capbure Setkings ...
Image Sharpening Eernel ...
Image Softening kKernel ...
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*  Cut + LCM All Selected Cells — If you select this, the next
time you choose either Cut Selected Cells or LCM
Capture Selected Cells, any arca marked to cut or capture
will be cut or captured, even if it was previously cut or
captured.

NOTE: If you do not have a cutting laser (Models 701 and 702),
only LCM Capture All Selected Cells is available on this

submenu.

Zoom — Enlarges the active roadmap, live video window or static
image. Choose the desired percentage zoom.

Save Image — Allows you to save an image. The image is saved to
the study directory and can be opened using the Study Tool. See
“Saving an Image” on page 47.

Export Image — Allows you to save an image as a bitmap, jpeg, or
tiff file. See “Exporting an Image” on page 48.

Image Properties — Opens the image properties window. See
“Image Properties” on page 47.

Get Full Cap Area — This will cut and capture a region the same
size as the cap. The application first draws the dissection marks on
the area and then performs the cut and capture.

NOTE: If you do not have a cutting laser (Models 701 and 702),
this option is not available.

Reacquire Roadmap Image — Allows you to acquire a roadmap
image for a selected slide. Use this command if Auto-acquire
Roadmap Images is not sclected in the User Preferences, or if
you want to reacquire a roadmap with a different light intensity.
For details on roadmaps, see ““T'he Roadmap Image” on page 43.

Adjust Brightness — Performs the same adjustments to the
shutter and lamp intensity to optimize brightness as the Auto
button in the Light Intensity section of the Microscope Tools.

Image Capture Settings — Opens the Image Capture Settings
dialog where you may set a margin of a given width around the live
video image. See the “Image Capture Settings Dialog” on page 60,
for details.
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Image Capture Settings Dialog

These settings can be used to crop pixels from the edge of the
image frame. By default, the maximum area of the camera’s CCD
1s used. It is common for CCDs to have lower response at the
extreme edge. If there are noticeable dark lines in the stitched
image, you may wish to crop the edges using the Image Capture
Settings dialog.

You may only change these settings when there is no active
session.

1. Choose Log Out from the User menu. The application will
open the instrument door, slide the work surface out and
remind you to unload the instrument. Finally, the System
Login dialog box appears, allowing you to log in.

2. Enter your name and password and click OK to log in
without starting a new session.

3. Choose Image Capture Settings from the Instrument
menu.

4. Enter the values, in pixels, for each margin around the image.
5. Click OK to save the changes.

6. 'The application will display a message informing you that the
changes will take effect after the application is restarted.

7. Dismiss the message and then the application will exit.

8. Restart the application, log in and begin a new session to use
the new settings.
Image Sharpening Kernel — This option is unavailable.

Image Softening Kernel — This option is unavailable.

Instrument Menu

The Instrument menu allows you to make certain adjustments to
the microscope, as well as perform other instrument-related
functions. You can also use the Microscope Tools (see “The

Image Capture Settings x|

The following walues set the region of
interest in the camera CCD.

Thiz does not mean that the image will be
mizzing any pixels. The stage movement
will be adjusted accordingly.

Top: EE
Left 83:

Cancel |

Eottom: I 4 3:
Right [ 4 =]
0K I

Skark Bew Session, .. kel
Open Instrurment Door

Microscope Tools” on page 83) to make these adjustments. Objective %
. . . Filter *
Start New Session — Opens the instrument door and displays the _

. . . . . EPI Filkershutter 3
Material Loading window, where you specify the materials for the Capture Mode .
new session (see “Entering Information in the Materials Loading S .
Window”, below). If you are currently running a session, a dialog Lamp N
box appeats mfoirl;nm(% you that if you start a new session, the Viden Settings...
current session will end. Bulk Transfer Settings ...

Calibrate *
66 www.arctur.com techsupport@arctur.com 650.962.3020 888.446.7911 Version C



Software Menus

Entering Information in the Materials Loading Window

1. On the Caps tab, uncheck any positions where there are no X
loaded caps. Caps | Siide 1| Siide 2| Side 3]
7 d ¥ Supply 2 Loaded
. i . . Qe TM TTQ
2. Choose the type of cap you are using, either CapSure™ HS o i o
r re Macro. i
© CapSu ¢ acro ol etz V¥ Paosition &
¥ Pasitior 3 IV Pasition 7
V' Pasition 4 V¥ Pasition 8
' CapSure HS ' CapSure HS
" CapSure Macio " CapSure Macio

QK I Cancel | Lpply | Help |

3. Click the Slide 1 tab. Check Loaded, if needed. Enter 2 name _ _ _
) ) Caps  Shide1 | Side 2| Siide 3]
for the slide (or use the default name) and any notes you wish :
) i Slide Mame and Motes | Slide Image List | Slide Cap List |
to save with the slide data.
¥ Loaded
4. Seclect a study from the Add to Study drop-down list, or Lol 231
create a new study by choosing New Study and entering a M
study name. 4
* If you are using a membrane slide, check Membrane.
* If you are using a membrane frame slide, check El
Membrane and then Frame. _ :
Add to Study : IDUUQ'E vl
5. Repeat for Slides 2 and 3, as needed.
. . . . . Exizting Slide |
6. Click OK in the Material Loading window when you are
finished entering information about the loaded materials. oK | Cancel sl | Hep |

Open Instrument Door — Allows you to open the Veritas
mstrument door to unload and remove caps from the unload tray
and/or add or remove slides. When you are finished, click OK to
close the door. This option is available after you log in.

NOTE: Do not add new materials to the instrument using this
option; instead use the button on the Materials Tool.

Objective — Allows you to choose an objective (2x, 10x, 20x, 40x,
or 60x if your instrument is so configured). Choose Restore
Focus to move the objective back to the default focus position.

Filter — Allows you to choose a fluorescence filter. Choose None
(for no filter) or the appropriate filter for microdissection.

EPI Filter/Shutter — Allows you to open and close the shutter.
The shutter is open when Shutter has a check next to it.
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For the AutoPix 100e instrument, you may select a neutral density
filter. Filter choices are 100%, 25%, 10% and 1%.

Capture Mode — Allows you to choose between Manual
Capture and Semi-Automatic Capture.

*  Manual Capture allows you to scan the slide while you
point and fire the laser to capture cells. In Manual mode you
can also mark up a static image of the slide to select cells and
regions of interest before you fire the laser. Typically, the
system can be left in the Manual mode.

*  Semi-Automatic Capture allows you only to mark up a
static image of the slide to select all cells and regions of
interest before you fire the laser. This mode prevents you
from firing the laser on the live video image.

Camera — There are two option on the submenu: Color Camera
and Camera Control.

* The Color Camera option is checked to indicate the
presence of a color camera in the instrument.

*  Choose Camera Control to view the Camera Control dialog
box, where you may set various camera settings. The settings
in the dialog box are described below.

(amera Control Dialog

The following settings are available from the two tabs in the
Camera Control dialog,

On the Exposure tab: E
Integration — Turns on camera integration for the specified Evposure | Cobor |
number of frames. Use this in case of insufficient illumination, _';ft:g[atimiﬁ [ \hie Baiance

. . . C duto [ AWE| € Manual
such as particularly darkly stained tissue or fluorescent AP000000a0000 0000 Pl
illumination. When Auto is selected in this mode, the camera will - - -
integrate up to the specified number of frames to obtain sufficient = g
. T - - Shutter Spesd I
illumination; the default 1s Off. [0 — j o —
NOTE: Long integration times introduce substantial time lag in 5 g
the video image, making it difficult to position or focus the video.

N

Shutter Speed — Choose the desired speed. Under manual e ﬁ
control, the application will no longer change shutter speed to !
compensate for differing illumination levels due to objective and
visualizer selection. This means that light intensity levels will need Factoy et ok ] cace
to change over a wider dynamic range and there will be more
variation in the color temperature of the lighting,
AGC - Automatic gain control; allows the camera to select
electronic gain up to the maximum specified. Electronic gain will
introduce some additional noise into the video images. The default
is Off. For fluorescence imaging, you may obtain better results
with this turned on.
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White Balance — There are three modes for controlling white
balance, Auto, AWC and Manual, described below. AWC i1s the
default mode.

*  Auto — The camera constantly adjusts for optimal white
balance. Under normal conditions, this adjustment will not
be noticeable. However, if lighting conditions change
quickly, users may notice this camera adjustment (which can
take up to ten seconds). Additionally, the Auto setting can
lead to a “patchwork quilt” pattern on your images.

*  AWC - In this mode, white balance is adjusted based on the
current video image and then not changed until Reset is
pushed. For optimal adjustment, find a scene in which white
fills the majority of the screen. It takes approximately ten
seconds for this white balance adjustment.

*  Manual — In this mode, you can set the red (R-Gain) and
blue gain (B-Gain) manually.

On the Color tab, the following options are available: x]
Chroma Color, Pedestal and Detail — Optimum levels have been Evposure Color |
pre-set at the factory. Use the sliders for manual control of these .
. roma Calor 176
settings. ||
Gamma — Click the button, to depress it, for gamma correction. Pedestd {35
e . . DNR
T'he default is off. For fluorescence imaging, Gamma should be ———g———"

on. Detail 255

......\| MNegative Polarity |

DNR - Click the button, to depress it, to choose digital noise
reduction. The default is on.

Negative Polarity — Click the button to depress it, to create a
“negative” video image. The default is off.

Carcel

Factory Defaults — Click this button to restore the factory default Focon Defeuls o |

settings.

To save your changes, click OK. To close the dialog without saving
changes, click Cancel.

Lamp — Allows you to choose between White Light and
Activate EPI Lamp to illuminate the sample. You may have both
lights on simultancously.

*  White Light is available after materials have been loaded.

*  Activate EPI Lamp turns on and off the IIPI lamp used for
fluorescence applications. The EPI lamp requires several
minutes to warm up once it is turned on and before it can be
selected. When the lamp is ready, “EPI ready” appears in the
lower-right corner of the screen. Once the EPI lamp is
turned off, it must cool down sufficiently before the lamp
controller will turn it on again. This may take as long as five
minutes.

To view fluorescent labeled samples on a dark field, turn off
the white light by clicking Enable in the Microscope Tools
and open the EPI lamp shutter.
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NOTE: This option is only available if your instrument is
equipped with an EPI lamp (Models 702 and 704).

Video Settings — Allows you to adjust the camera settings for the
live video (for example, brightness and contrast), as described in
“Color Camera Dialog”, below. You can also access this dialog box
by right-clicking in the live video image. In most cases, you will not
need to make any changes to these settings.

Color Camera Dialog
This dialog box allow you to adjust the camera settings.

For all the parameters on the Acquisition Settings tab, use the =
slider or enter a value in the text field. These parameters are: Aquisition Settings | Fiers settng |
Contrast, Brightness, U Gain, V Gain, and Video Hue. Conirast ] T
Reset — Click this to return to the default values for these Biighimase. ' j o e
parameters. i '
U Gain : I J I |1_
Y Gain: : )l : [
Wideo Hue : I J I lg—
Reset |
On the Filters Settings tab, you may set the following parameters:
Advanced Users Only — Check this to enable the other controls. =
Once the controls are enabled, choose the desired option from the Aquisition Settings  Fiters seting |
list. v
. . . 3 Caolor Trap : Gamma Comection Removal :
The following options are available: Color Trap, Corring, [Eratle =l [oeabe =
Chrominance AGC, Low Color Detection & Removal, _ _ _
. . . . Carring : VYideo Lows Pass Filber :
Gamma Correction Removal, Video Low Pass Filter, Vertical e Sl o &
Luminance Comb Filter, and Vertical Chrominance Filter.
) ) ) ) Chrominance AGC : Wertical Luminance Comb Filter :
Bulk Transfer Settings - This option is unavailable. [Disable =] [rtemolation =]
Calibrate - This option is unavailable. Low Color Detection & Removal:  Vertical Chraminance fiter:
|Disable x| |Disable =l
Materials Menu
Use the commands on the Materials menu to move caps and slides Activate Shide v
from one area to another on the work surface. Sl P = [ e
Activate Slide — Allows you to choose a specific slide for analysis. Move Cap To »
This option is available once materials have been loaded. i i
MMaterials Broperties, ..
Place Cap At Region Center — Moves the current cap to the Active Slide Properties. ..
sclected location of the active slide. This option is available when a fctive Cap Properties. ..
slide 1s active (an active slide has a red border around it).
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Move Cap To — Moves the current cap to the QC station, slot
(slide) 1, 2, 3, or the unload tray. This option is available when a
cap is active (an active cap has red circle in the center).

Materials Properties — This option is unavailable.

Active Slide Properties — Displays the properties for the active
slide. This option is available when a slide is active. See “Slide
Properties” on page 40 for more information.

Active Cap Properties — Displays the properties for the active
cap. This option is available when a cap is active. See “Cap
Properties” on page 43 for more information.

User Menu
The User menu options depend on whether a user or an
drmini 1 di Log k. ..
administrator is logged in. e e
Log Out — Allows you to log out of the system. Preferences. .. Chrl+U

Change Password — Allows you to change your password. User Manager

Preferences — Displays the user preferences. See “Setting User Administrator

Preferences” on page 36 for more information.

User Manager — Allows an administrator to see a list of all users Log Cuk, .,

in the system, and to add, delete, or edit user information. Change Passwoard. ..

Available to administrators only. Preferences, .. Chrl+U
User

Window Menu

The Windows menu displays a list of all windows currently open in
the application. Choose a window from the list to make it the
active window and bring it to the front.

Help Menu

About Veritas — Displays the About Veritas dialog showing the

L . . o ; Abouk Yeritas |
application version number. Click OK to dismiss the dialog box.

About Yeritas x|

m Yeritas Version 2056 ak. |
Copyright [C] 1999 - 2005
et
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Displaying System Info

Click System Info in the About Veritas dialog to show
information about the system. You can sce information about the
system and the lamp.

System Information

Syztem Info | Lamp Infa I

MFG: 042704
Firrare: 2.0.1.39
Hardware; 001CF1
Serial Mumber: A02
SWDate: 090304

Help |
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6. Software Tools and Toolbars

This section describes the Veritas™ application tools and toolbars.

There are eight tools, listed below in alphabetical order. Each tool
1s described in more detail on the corresponding page.
*  The Capture Groups Tool — below

*  The Capture Laser Tools — page 76

*  The Cutting Laser Tools — page 78

*  The Materials Tool — page 79

*  The Microdissection Tools — page 80

*  The Microscope Tools — page 83

*  The Navigation Tool — page 86

*  The Study Tool — page 87

There are two toolbars in the application:

*  The Static Image Annotations Toolbar — page 90
*  The Annotations Font Toolbar — page 93

The Capture Groups Tool
The Capture Groups Tool allows you to mark different tissue x|
targets, containing the same cell types, to be collected together on
the same cap. For instance, you may have two different types of Groups Hame humber firea
cells on one slide, both of which you are interested in assaying A clear 2 2.11mm?
separately. You can create two groups, one for each type of cell. C I suspicious | AR s
When you capture, you can capture the first group on one cap and LIS g Opn=
the second group on another cap. mb 0 O

E 0 Opar 2
Each group is displayed in a different color on the screen, making F n M2 T
it easy to distinguish between them. You can assign a name to cach K1 — >
capture group. The number of items in the capture group is shown dies | 22w
in the Number column and the total area for each group is shown

in Area column.

"To name a capture group, click in the Name cell for the group and
type the name.

There area three controls at the bottom of the Capture Groups
Tool.

*  The controls at the bottom left of the tool allow you to view ﬂ ﬂF

ﬂ .ﬁ.ream |

*  The Area ficld updates to show the area of the currently ‘ ‘ ‘ ‘ ‘
selected item. First Previous Next Last Properties
*  The Properties button allows you to set the properties of
the capture group, as described below.

all items in the capture group.
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Adjusting Capture Group Properties

You can set the properties for each capture group, including details
of the cutting and capture laser and the color in which the group
will be displayed on the screen. These changes apply to any new
dissection marks in this group. The properties of existing
dissection marks in this group will not change.

Only the properties relevant to the type of dissection marks you
create will apply. Por instance, if you only use the LCM
Microdissection Tools to mark cells for capture, then the Cut
Properties will not be used.

NOTE: You may wish change the properties of a single dissection
mark; to do so, see “Adjusting Dissection Mark Properties” on
page 83.

1. Seclect the group by clicking on the letter next to the group in
the Capture Groups tool.

—or—

Use the UP and DOWN arrow keys to scroll through the list
of groups.

Right-click and choose Properties from the menu.

Click Properties in the Capture Groups Tool.

The Cut Properties tab has parameters which pertain to the
cutting laser. If you do not have a cutting laser, this tab is not
shown. Depending upon the type of slide you are using,
different parameters are used by the system.

» To change the color of the line representing the path of the cutting

laser, click Select Color, choose a color from the Color
dialog box, and click OK.

(2 [x]

Color

Basic colors:

B0 T 0

LCustarn colors:

N o o
N o

Define Custom Colors »»

Cancel |
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You may sct the following parameters for membrane slides: x|
e To disable tabs, uncheck Enable Tabs. Tabs are short

Cut Properties | Capture F'roperliesl Line F'roperliesl
regions that are not cut and which prevent the tissue from

tembrane Slides Glass Shides

curling off the slide before the capture laser can attach the T Bt T
CapSure ™ film to the tissue. If this is not checked, no Cut ‘width
tabs will be generated and the cutting laser will cut entirely Vi ot Tabs [ 4 [ s
around the region. Spacing Iﬁ

* To change the number of tabs and other tab parameters, enter the size [ 6
following information: Min. # Tabs is the number of

tabs in the region. Spacing is the distance between the ~ Line Appearance

tabs, in um. Size is the length of the tab, in pm. I S elect Calar |

You may set the following parameters for glass slides:

* To change the width of the cutting laser, enter a number in pm,
in the Cut Width field. If the Cut Width 1s larger than the
Cutting Laser Spot Size, the Veritas™ application will
round down until the Cut Width can be evenly divided by ok | Cores apely Help
the Cutting Laser Spot Size. (For example, if the Cut
With is 7 uym and the Cutting Laser Spot Size is 2 pm,
then the application will adjust the Cut Width to 6 pm.)

Properties For the "Heart™ Group ll

4. In the Capture Properties tab, you may set the parameters

pertaining to the capture laser. As before, there are different Cut Propetties  Capture Praperties ||—i”E Propeties |
parameters for membrane and glass slides. Membrane Shides Glass Slides

For membrane slides: LCM Spots Per Tah

1 5

Spot Overlap

Hariz I*iﬂ—
Wt IF

* Set LCM Spots Per Tab. The capture laser spots are used
to fuse the tissue to the cap.

* Check None if you don’t wish to place any capture laser

< e : ; Exclusion
spots. Use this option .When you are plz.mmng to F Nons Overep [0
mechanically extract the tissue; the system will use the
cutting laser to cut around the region but will not use the
capture laser. Restore Defaultsl Restore Defaultsl
* Click Restore Defaults to return to the default values. Spat Appearance———————
For glass slides, the capture laser spots are arranged in i M Filed  Select Cnloll
parallel rows, covering the entire area to be captured.
The following parameters influence the position of the ok | cancel | Epply | Help
spots:

* To control how much the capture laser spots will overlap each other,
change the Horizontal and Vertical ficlds in Spot
Overlap. Horizontal controls how much two adjacent
spots on the same line cover each other; Vertical controls
how much a spot will over lap a spot on the next line. The
greater the values, the more the spots will be situated on
top of each other. Enter a number from 0 to 99.

» To adjust the degree to which the laser target spots for the area of
interest extend into an excluded region, change the Overlap (in
the Exclusion area of the dialog box). For example, if the
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Dissection Exclusion Region tool is used to designate
an area to be excluded from capture, some of the capture
laser spots may extend past the border into the excluded
region. The Overlap defines the degree to which these
targeting spots extend into the excluded region. Spots with
a higher percentage of their area overlapping the excluded
region than is defined by Overlap will be deleted.
* Click Restore Defaults to return to the default values.

If desired, change how the capture laser spot is displayed on
the screen.

* Change the capture laser spot fill. You can fill the spot or
display it as an outline. Check Filled to fill the spot;
remove the check to display an outline.

* Change the capture laser spot color. Click Select Color,
choose a color from the Color dialog box, and click OK.

5. Click OK to save the changes. These changes apply to any
new dissection marks in this group. The properties of existing
dissection marks in this group will not change.

The Capture Laser Tools

The Capture Laser Tools allow you to make adjustments to the
capture laser. The Capture Laser Tools are not available until you
place a cap on the slide or choose Capture Laser from the Tools
menu.

The Capture Laser Tools have two modes. In one mode, the
number of laser fires to cover the area sclected is shown. In the
second mode, the total area of the selected region is shown in
square microns. See “Setting User Preferences” on page 36 for
instructions on choosing the mode.

NOTE: The cutting laser, if installed, 1s adjusted using the Cutting
Laser Tools, described on page 78.

Enable — Turns on the laser and allows you to adjust the settings.

Matrix — Allows you to set up a test firing pattern to determine the
appropriate laser settings to adequately wet the film. For detailed
information on using a matrix, see “Using a Calibration Matrix to
Determine Capture Laser Settings” on page 78.

Fire/Capture — Pulses the laser according to the specified # Hits
and Delay. For example, if the # Hits is 4 and the Delay is
10 msec, the laser will pulse 4 times with a 10 msec pause between
each hit. A counter keeps track of how many times you fire. You
can reset the counter at any time by entering 0 in the text box.

Color 2]
Basic colors:
JO 105

LCustom colors:

N o o
N o

Define Custom Colors »» |

Cancel |

Capture Laser K|
¥ Enabls P atriz I
—Fire Settings— — Lazer Focuz—

Fire: I Fine Control

bd =z Fire Limnit

ID[no lirnit) :
Power -
I?D i :
Fulze

ﬁHlts il il

Dela Coarse Caontral
ID msec

Feset I
Intenzity

IZDD m Res Defaults I

Set Set Spat Size |

Laser has NOT been located! |

Capture Laser Tools set to show
the number of fires to cover

the area (Fire Counter selected on
Toggle Laser Tool menu)
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NOTE: The counter considers the value in the # Hits field as a
single fire. For example, if you enter 4 in # Hits, although the
laser pulses 4 times, the counter registers 1 fire.

Max Fire Limit/Max Area Limit — Allows you to enter a
maximum number of laser fires or the maximum area to capture,
for a static image. When the Max Fire Limit/Max Are Limit is
reached, the capture stops.

Power — Sets the laser power between 3 mW—100 mW.

Pulse — Defines how long the laser fires. Enter a value from
100 psec to 1,000,000 pscc.

# Hits — Determines the number of times the laser actually fires
when you click the Fire button. For some tissue, multiple pulses
may be necessary to achieve proper wetting,

Delay — Sets the pause between each laser fire.

Intensity — Sets the degree of laser light for the targeting beam. If
you can’t sec the laser beam when focusing, set Intensity to
200 mV, then turn it down once you’ve focused the beam. Click
Set after entering the Intensity value.

Laser Focus — Allows you to use a fine control and coarse control
to focus the laser beam. Click Reset to return the fine and coarse
controls to their default values. For information on focusing the
laser, refer to “Manually Focusing the Capture Laser Beam” on
page 49.

Set Spot Size — Allows you to measure the spot size of the capture
laser. The application uses this to control the movement of the
stage during capture and to calculate the arca of tissue that will be
captured. For information on optimizing the laser spot size, refer
to the following section, “Optimizing the Capture Laser Spot
Size”.

Laser Status — Click the Laser has NOT been located button to
locate the capture laser. If the location of the capture laser is
known, the text changes to “Laser has been located.”

Optimizing the Capture Laser Spot Size

To optimize the spot size for the capture laser, start with the
following initial settings and test fire the laser to ensure adequate
wetting (See “Manually Measuring the Capture Laser Spot Size” on
page 51 for instructions on wetting the film).

*  Por CapSure™ HS Caps start with Power at 60 mW and
Pulse at 1500 psec.

*  Por CapSure Macro Caps start with Power at 50 mW and
Pulse at 1000 psec.

For dissecting individual cells, you may want to use a very small
spot size.

=
|7 |E bd atrix I
— Fire Settings — — Lazer Foous—
LCapture I Fine Contral
Oy s
tdax drea Limit =
0.00ro linnit) E
Proer =
B0 it :
Pulze :
|1 B00 peec -
f Hits
: 4| +|
Dela Coarze Control
Iﬁsec; Rezet I
Intenzity
|2E|E| iy Res. Defaults I
Set Set Spot Size |

Laser has NOT been located! |

Capture Laser Tools set to show
total area of regions to capture
(Area Capture selected on Toggle
Laser Tool menu)
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o To minimige the spot size, use the lowest Power setting that
produces an adequate wetted spot. Sometimes it is easier to
obtain smaller spots by using very low Power and Pulse
settings and increasing the # Hits sctting,

. To increase the spot sige, start by increasing only the Pulse
setting. Then, if necessary, increase the Power.

Using a Calibration Matrix to Determine Capture Laser Settings

The laser matrix option allows you to sct up a test firing pattern to
help you determine the appropriate settings for the capture laser to
adequately wet the film. The settings in the Capture Laser Tools
are used as a starting point, then modified based on the values you
enter in the Calibration Matrix window.

# Steps scts the number of intervals (rows and columns) for the
pulse and power parameters.

Stage Offset scts the distance (from center to center) between
spots.

Laser Offset allows you to set the values at which the power and
pulse will increment each step.

For the example shown in the Calibration Matrix window, if you
set the Lsr. Offset for Power to 20, and the Power in the Capture
Laser Tools 1s set to 40 mW, at three steps, you will get a laser hit
at 60, 80 and 100 mW. If you set the Lst. Offset for Pulse at 250,
and Pulse in the Capture Laser Tools is set to 450 psec, at three
steps, you will get a laser hit at 700, 950 and 1200 pscc.

NOTE: You can use the # Hits and Delay in the Calibration

Matrix window to override the settings in the Capture Laser Tools.

Enter the appropriate values, then click Fire. The laser will fire in a
matrix pattern with three columns of increasing pulse (bottom to
top) and three rows of increasing power (left to right).

Choose the Power and Pulse values that give the best wetting in
the matrix and enter them into the Capture Laser Tools.

The Cutting Laser Tools

The Cutting Laser Tools allow you to make adjustments to the
cutting laser, if your instrument is so equipped. Choose Cutting

Calibration Matrix [ x|

bd atrix
# Steps Stg. Offget Lar. Offset
Fows
Fower |3 100 f20
Columms |3 |1nu |250
Fulze
# Hitz Delay
Laser I1 IU Fire: I

g PR

Power (offsetof20) — 3

Pulse (offset of 250)

Cutting Laser

X

Final spot

power: 100 mW
pulse: 1200 psec

‘ (apture Laser

Tools set to:

power: 40 mW
pulse: 450 psec

Laser from the Tools menu to view the tool. Pulse e e
. . . - 0
Pulse — Click this button to pulse the cutting laser. - 7w
Spot — Allows you to measure the spot size for the cutting laser; D & Law
see “Measuring the Spot Size for the Cutting Laser”, below. Once Spot: 2. 0um - Med
you have measured the spot size, the size is shown on the button. ) £ High
Restore Defaults — Click this to restore the power and spot size Festare 'IJ:
to their default values. Defaults - 10
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Laser Power — Choose between Low, Medium or High. Use the
slider for finer control of the laser power at the selected setting,
The exact power is shown in the field above the radio buttons.

Measuring the Spot Size for the Cutting Laser

1. To measure the spot size, click Spot and enter a value for the
spot stze.

—or—

* Perform a cut.

* Use the Ruler tool to measure the width of the cut
(Change to a higher objective if you need to sce the cut
more clearly.)

* Click Spot and enter the width you measured with the
ruler.

2. Click OK to save the changes and close the dialog box.

The Materials Tool

The Materials Tool allow you to see the locations and types of
slides and caps on the work surface. Use the Materials Tool to
activate slides and to move caps to the slides, the QC station or the
unload tray. You can also open and close the mnstrument’s door,
rename slides, and change the study.

In the Materials Tool:

* A white slide represents a slide present but for which no
roadmap has been acquired.

* A thumbnail of the slide represents a slide present for which
a roadmap has been acquired.

*  The active slide has a red border drawn around it.

*  The boundary of the region where caps may be placed is
shown by a red dotted rectangle. You cannot place the
center of a cap beyond the dotted line.

*  To change the skide type, check or uncheck Membrane Slide as
appropriate.

o To change the current study for the active slide, choose the study of
choice from the drop-down menu.

*  To open the instrument door, click Open Door.

. To start a new session, click New Session. The instrument
door will open, allowing you to remove any materials. Once
you have done this click OK on the dialog box. The door
will close, then open again. Load the new slides and/or caps,
then click OK in the dialog box. The door will close and the
Material Loading window will appear.

o To change the properties the active skde, click Properties. The
Slide Properties dialog for that slide will appear. Make any
changes and click OK to close the dialog. (See “Slide
Properties” on page 40 for details.)

Cutting Laser Spot Size Measure i[

Uz the mouze to click on each side of cut area in
the live video dizplay to determine the cut zize.

Spot Size: |2.EI|.Lm
(1] I Cancel |

Membrane Slide: v r

Offload

ac
QOO0
QOO
QOO

I Slot

~

3

Slot 2 | Slot 3 |

Active Slide:

Open Door | |5|iden229

NewSessiunl IDnugie vl Prnpertiesl
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The Microdissection Tools

The Microdissection Tools allow you to designate cells for capture
and initiate the capture process. Use these tools on either the live
video image or a static image. If you are marking cells on a static
image and save it, these dissection marks are also saved.

Common Tools

The following tools are common to all of the tabs: the Hand, the
Ruler, Go Capture and Autoscan.

Hand — Allows you to move the stage by dragging in the live video
window. Click on the tool and the cursor will change to a hand. in
the live video window, click and drag. The stage will move as

needed and the live video image will update to show the new area
of the slide.

Ruler — Allows you to measure the length of an item on the
screen. Click once at the end of the item, then drag the mouse to
the other end of the item. The application draws a line on the
screen and the length of the line is shown in a tool tip. Click again
to reset the beginning of the line to the current location. When you
deactivate the tool, the line disappears. This tool operates on the
roadmap, the live video or a static image.

Go Capture — Allows you to cut and capture all the marked cells
in one step. This button is enabled once you have a dissection
mark on the live video image or a static image.

Autoscan— Allows you to train the system to automatically
identify cells for capture. See “Introduction to Auto Scan on a
Static Image” on page 55 for detailed instructions on this feature.

Using the Tools

. To activate a microdissection fool, click on the image then click on
the tool to select it.

. To deactivate the tool when you are finished, click the tool again.

*  Toswitch between tabs, use the arrow keys or click on the tab of
interest.

The Cut and Capture Tab

If your system is equipped with a cutting laser (Models 703 and
704), the Cut and Capture tab is present. The tools in this tab allow
you to mark areas where you wish to use the cutting laser to outline
a region for capture.

Free-Form Cut and Capture Region — Allows you to outline a
region to be captured. Click and drag to outline a region. When
you release the mouse button, the region is automatically closed.
The application displays an outline of the region to be captured as

icrodissection x

Cut and Capture | LIk I Ahlatel

MEsE —HE e

i Live Yideo forSlide: Slide #6

Microdissection |
Cut and Capture | LCH I .&I:ulatel

MEsE —HE e

-
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well as any tabs (regions where the tissue won’t be cut) and the
positions of the capture laser spots.

To capture a region the same sige as the cap, use the Get Full Cap Area
command on the Image menu; for more details see page 64.

Circular Cut and Capture Region — Allows you to outline a
circular region to be captured. Click and drag to outline a circular
region. The application displays an outline of the region to be
captured as well as any tabs (regions where the tissue won’t be cut)
and the positions of the capture laser spots.

>

See “Adjusting Capture Group Properties’
information on setting the tabs and the capture laser spots for
dissection marks created using these tools.

on page 74 for more

The LCM Tab

The tools on this tab are used to choose which cells the capture
laser will capture. Use these tools if you have only a few cells to
capture.

These tools operate on both the live video image and a static
image.

The dissection marks are displayed as spots, using the spot size of
the capture laser. The diameter of the targeted point represents the
diameter of the wetted area on the film, once the capture laser has
fired. If you did not measure the spot size, the application uses
10 pm. (See “Manually Measuring the Capture Laser Spot Size” on
page 51 for instructions on manually measuring the spot size.)

For all of the LCM Microdissection tools, you can adjust the
overlap and shift of the capture laser spots (See “Adjusting
Capture Group Properties” on page 74).

Single Point Dissection — Allows you to target cells individually
for capture. Click to mark individual points on the image.

Dissection Line — Allows you to draw a line on the image to
capture a layer or line of cells, for example, to capture an epithelial
cell layer. Click and drag to draw the line. The line represents the
cells that will be captured by the laser as it fires at each spot on the
line.

Free Form Dissection Region — Allows you to draw an area on
the image to identify an area to be captured. Click and drag to draw
the region. Release the mouse to close the region.

Dissection Exclusion Region — Allows you to desclect a specific
arca that you don’t want to capture within a region. Before creating
the area of exclusion, first define the region to be captured with the
Free-Form Dissection Region tool. ALT-click on the region to
select it, then click on the tool and click and drag to draw the
exclusion region inside the region.

icrodissection x

Cut and Capture LCM |.-’-'-.I:|Iate|

Dl k=) =) = B | ] |nuee|

3
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The Ablation Tab

If your system is equipped with a cutting laser (Models 703 and
704), you will see the Ablation tab. These tools allow you to mark
arcas where you wish to ablate tissue using the cutting laser.

For all of the Ablation tools, the width of the lines is based upon
the Cut Width, sct in the Capture Group Properties dialog box,
(See “Adjusting Capture Group Properties” on page 74).

Free Form Ablation Region — Allows you to outline a free-form
region to be ablated. Click and drag to draw the region. When you
release the mouse button, the region is automatically closed. The
application displays lines inside the region to indicate the path of
the cutting laser. (Depending upon the magnification, the region
may appear filled.)

Ablation Exclusion Region — You can exclude cells or tissue
from ablation within a region defined by the Free Form Ablation
Region tool. To do this, first mark the region to be ablated. Then
ALT-click on the region to select it, and then click on the tool and
click and drag with the Ablation Exclusion Region tool to mark
the area to be excluded from ablation.

Working with Dissection Marks

Once you create a dissection mark, you can move, hide, or delete it
You can also show its properties.

To select a dissection mark, hold down the ALT key and click the
dissection mark.

To move a dissection mark, Al.I'-click on it to select it, then drag
it to a new location.

To hide a dissection mark, A1.1-click on it to select it, then right-
click and select Hide. When the cursor is over a hidden
annotation, it changes to a hand with red lines radiating from
it. You can redisplay the dissection mark by right-clicking the
arca where the dissection mark is hidden and selecting
UnHide.

NOTE: Although you may hide a dissection mark from view,
the selected cells will still be captured.

To delete a dissection mark, right-click the dissection mark and
select Delete. You cannot delete a dissection mark if you
have already captured the cells.

NOTE: To delete created by the
Dissection Exclusion Region and the Ablation Exclusion
Region tools, you must delete bozh dissection marks.

dissection marks

To show the properties of a dissection mark, right-click the
dissection mark to select it and select Properties to view the
Annotations “Adjusting
Dissection Mark Properties”, below, for more information.

Properties dialog box. See

|

Microdissection

Cut and Capture | LCH

2 o &

Ablate |
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Adjusting Dissection Mark Properties

You can adjust various properties of a dissection mark. The
properties of a dissection mark are a subset of the Capture Group
properties, based upon the type of dissection mark you have
selected.

For example, if you have created a dissection mark using one of
the LCM tools, the properties of the cutting laser won’t be shown
because the cutting laser won’t be used during microdissection.

See “Adjusting Capture Group Properties” on page 74 for
information on the various properties for a dissection mark.

The Microscope Tools

The Microscope Tools allow you to adjust the image you see in the x|

live video image. After adjusting the settings, you can save the

. . i — Objective; - Objective Focus — Light Intensity —
microscope scttings to a file by selecting Save Defaults from the I I Fine Coarse pg Enahle d
File menu. 2

- . — [l [ 1 al |
Set Objective — Allows you to select from the four objectives: 2x, 10 Ifl — ] e
10x, 20x, and 40x (or 60x if your instrument is so configured). You — 0 -IJ A B T
can also select the objective by choosing Objective from the I 20 +
Instrument menu and then the objective from the submenu. s | | 7 Stored Postans
The Veritas™ Microdissection Instrument is calibrated so the E— |_<| ;I [ Llll ;I _| ><*'-'*"l

objectives are parfocal. If you focus at 40x (or 60x if your
instrument 1s so configured) and then change the objective, the
image should remain in focus.

Capture Image | Adjuzt Camera | Fluorezcence |

Hed Greenl Elue | [zer I Nunel Shutter |

NOTE: You must focus at the highest objective (40x or 60x) to
take advantage of the parfocality. The depth of field for the
higher objectives is narrower than for the lower power objectives.

Objective Focus — Provides auto focus, coarse, and fine
adjustments. Click AUTO to automatically focus the microscope
at the selected objective. When the fine control is active, you can
also use the UP and DOWN arrow keys to make fine adjustments.
The height of the objective above the slide 1s shown between the
arrows for the coarse controls.

Light Intensity — Allows you to adjust the amount of light
emitted by the white lamp. Check Enable to turn the light on and
enable the slider. When the slider is active, you can use the Up and
DOwN arrow keys on the keyboard to adjust the light intensity.
When Enable is unchecked, the light is off and the live video
image will appear black. Click AUTO to automatically set the
brightness.

Stored Positions — Use these controls to store the locations of
any areas of interest. Once you have stored the positions, you can
easily navigate through them at whatever magnification you
choose. See “Saving Positions of Interest” on page 84 for more
information.
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Capture Image — Click this to create a static image from the
current live video image. The instrument will capture a static image
and display it on the screen. The application draws a red box on
the roadmap at the location of the static image.

Adjust Camera — Click this to open the Camera Control dialog
where you can override the default settings for the camera (sce
“Camera Control Dialog” on page 68). For most situations, you
will not need to make changes to these controls.

Fluorescence — Click this to turn on the fluorescence lamp and
enable the controls specific to epi-fluorescence. These controls are
described below. If your system is not equipped for epi-
fluorescence, this button 1s not enabled.

NOTE: It takes several minutes for the fluorescence lamp to warm
up. When the lamp is ready, “EPI ready” appears in the lower
right corner of the screen. If you turn off the fluorescence lamp, it
must cool down sufficiently before the lamp controller will turn it
on again. This may take as long as five minutes.

Additional Controls for Epi-Fluorescence

These controls are only available on Model 702 and Model 704 x|

instruments and are only enabled when the Fluorescence button

X . : K . . i, — Objective — Objective Focus — Light |ntensity —
has been clicked. See “Microdissection of Fluorescent Samples” on ! ! Fine Coarse pg Enable ¢
page 52 for more information. = B I 4 I

S— B
Filter buttons — Allow you to select between the red, blue, or 10 u U
: . T Co0m || 7 €3
green filter when using the fluorescence lamp. Choose None (no — O -IJ 0
filter) to view the sample under white light. Choose the appropriate I 20K +
excitation filter when performing fluorescence LCM. If you have a ~Ctored Posttions
UV filter installed, the User button will say UV. B0 |_<| Ll [ LI Lll ;l _I 5 Alll

Shutter — Use this to open and close the shutter on the

fluorescence lamp. When the button is depressed, the shutter is Copture Image | - _Adjust Camers | I o
open. To avoid photo-bleaching the sample, close the shutter
except when you are viewing the sample. When you are not [Fed Green | Blue | User | Mone | _Shutter |

viewing the sample, for example, after you have acquired a static .
image, click Shutter to close the shutter. Microscope Tools for EPI-fluorescence

Saving Positions of Interest

The Microscope Tools allow you to save locations on the slide that
are of interest at one magnification, and then easily find them at
any other magnification. This operates only on the live video
image.

Storing Positions
1. Navigate to a location of interest in the live video.

2. Click the + button in the Microscope Tools. The location is
now saved.
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Moving to Stored Positions Stored Positions
1. To move to the next position in the list, click the > button. <] < I | 2 I | | + | ) | <Al I
|
—or— ‘
To move to the previous position, click the < button. Position number Save Delete  Deleteall
To move to cither end of the list, click either | < or >|. .
Move to first or Move to next
The stage will move as needed to place the center of the previous position or last position
saved location in the center of the live video image.
Deleting a Stored Position
1. Use the controls to move the stage to the saved location that
you wish to delete.
2. Click the —button to remove the location from the list.
—or—
Click the X All button to delete all the stored locations in the
list.
The next time you save a location it is added to the end of
the list.
Customizing Settings for the Laser and Microscope Tools
FEach time you log in, the application automatically sets the
parameters for the Laser and Microscope Tools to the values in
your default settings file. If you have never saved the settings, the
default file (named SystemDefault), is automatically loaded.
If you wish to change the settings for either or both tools, and
make them the new defaults, you may do so. You may also wish to
create settings files for each type of tissue, or for fluorescence and
non-fluorescence work or for some other reason. Using a saved
settings file lets you quickly set up your system for an LCM
session.
NOTE: The settings file in use when you log out becomes the new
default file for your next LCM session.
Saving Defanlt Settings
1. Choose Save Defaults from the File menu when you want to
save the laser and microscope settings.
The settings file that is currently loaded is automatically
updated with the current settings.
* If you are an administrator, and you are currently using the pertas i

SystemDefault settings, an error message appears asking if & N ,
ou are currently using the 'SystemDefault’ default set. Are You Sure you want ko change it?

No |

you want to overwrite the file. (This message also appears
if you have selected the Auto Save Default option in User
Preferences; see “Setting User Preferences” on page 36.) If
you choose Yes, the new laser and microscope settings will

be used as the SystemDefaults for the entire system.
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To avoid overwriting the SystemDefaults, choose No and
then choose Save Defaults As from the File menu. Enter
a file name and click Save As.

* If you are not an administrator, you will not be allowed to
overwrite the SystemDefaults file. If you want to save the
settings, choose Save Defaults As from the Iile menu.
Enter a file name and click Saves As.

Loading Saved Settings from a File

If you wish to use a previously saved settings file, rather than the

default file, load that settings file. You might wish to do this, for

instance, if you have different settings for cach type of tissue you

study.

1. Choose Load Defaults from the File menu at the beginning
of your LCM session.

2. Choose the file withe the laser and microscope settings you
want to load and click Load.
If you log out without loading another settings file, this file
will become the default. (The settings file last in use, before
you log out, become the default for your next session.)

Deleting Default Settings

1. Choose Save Defaults As from the File menu.
2. Choose the settings you want to delete and click Delete.

3. Click Yes in the confirmation dialog box to delete the
settings.

The Navigation Tool

The Navigation Tool provides another way to move the live video
tmage to look for areas to capture. Click the black dot in the center
of the bull’s-eye and drag in any direction towards the edge. Hach
time you move the black dot, the stage moves. The speed of the
movement is proportional to the distance the black dot is pulled
away from the center of the Navigation Tool. When you release
the mouse button, the black dot snaps back to the center point and
the work surface movement stops.

Save Default As x|

Default Mame

MC lung
SpstemDefault
Cancel
Delete

Filename  |new defaults

Load Default Settings x|

Default Mame

3n tiszue
MC

Canc;
Delete

Load Default 5ettings x|

Default Mame

I__oad

Cancel
LDelete

Mavigation Taals
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The Study Tool
The Study Tool allows you to see how study data is organized and Study Tool x
saved, and to access study, slide, cap and image data. You can see =1 Studies
and access only the data for studies that you created. & Study!
E|[:l Study3
. To activate the window, click in the white area where the tree =-a %E'T w7
. = mages
diagram appears. L[] #0 Roadmap Imags for Slide H17
. To display the properties for a slide, an image or a cap, right-click on =3 Slide 42

EID Images

BISNg i1 oadmap Image for Slids #2
. . . . #14 Roadmap Image for Slide #2
*  To open an image, double-click the name or right-click and S CAPs

choose View.

the item and choose Properties.

*  To delete a study, a slide or an image, right-click the object and
choose Delete.

*  To rename a study or a slide, right-click the object and choose

Rename. " Study Data

NOTE: You cannot rename the active slide.
In the Study Tool window, you can manage study data in various

ways, described below.

Moving a Slide to Another Study
To move a slide from one study to another:
1. Right-click on the slide you wish to move and choose Study Tadl

Move to.
A dialog box appears, allowing you to choose a study.

Properties
Rename

2. Click on the study of choice to select it and click OK.

archi
The slide is moved to the sclected study. .

Delete
Mave Ta...

If a slide already exists with this name, a dialog box appears e
opy To.,

giving you the chance to rename the slide. Enter a new name

and click OK. " Study Data I

Copying a Slide to Another Study

To copy a slide from one study to another:

1. Right-click on the slide you wish to move and choose
Copy to.
A dialog box appears, allowing you to choose the study
where you wish to move the slide.

2. Click on the study of choice to select it and click OK.
A copy of the slide 1s made and placed in the selected study.

If a slide already exists with this name, a dialog box appears

giving you the chance to rename the slide. Enter a new name
and click OK.
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Archiving Study Data

You may wish to archive study data to a another place. You may
archive all studies, a selection of studies, a slide or a selection of
slides.

1. Click on the item you wish to archive.
To select more than one item at a time, use CON'TROI-click
when selecting,

2. Right-click and choose Archive.
A dialog box will appear where you can select the destination
for the archive.

3. Click OK to save the archive.

The application will display a message when the archiving
process is complete.

Restoring Archived Study Data

You may wish to restore study data that has been archived. You
may restore all studies, a selection of studies, a slide or a selection
of slides.

1. In the Study Tool, click on the study where you wish to add
the restored data.

2. Right-click and choose Restore.
A dialog box will appear where you can choose the archived
study data that you wish to restore. Studies have the file
extension “.ast” and slides have the extension “.asl”.

Study Tool

-y T
Properties
..... Rename

i Archive
Restore
Delete

B2 Study Data I

AutoPix 100 x|

1 J [Default] 1 is successfully archived,

Study Tool

oy R
i 1. Properties
] o Renarne

..... Archive
Restore
Delete

B3 Study Data I
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3.

Choose the data to be restored and click Open.

If you are restoring a study and the name of any study you
are restoring is the same as an existing study, you will see a
dialog box informing you of the conflicting names.

Choose one of the following options and then click OK to
begin restoration:

* To add the contents of the study to the study of the same name,
choose Merge. If any names in the two studies are the
same, the names of the archived items are made unique by
adding the date and time after the name, e.g Slide #37
becomes Slide #37 [20040401 15.58.07.0363].

* To overwrite the items in the study with the items from the archive,
choose Overwrite.

NOTE: This option will replace the newer item with the
item from the archive.

* To add the archived ttems and make their names unigue, choose
Make Unique. The names are made unique by adding the
date and time after the name, as above.

If you are restoring a slide or have chosen to merge a study,
you may have slides with the same names. As before, the
application will display a dialog box informing you of this.
Choose one of the following options and click OK.

* To add all the slides to the existing study, choose Merge. If any
names are the same, the names of the archived items are
made unique by adding the date and time after the name,
eg.  Slide #37  becomes  Slide #37  [20040401
15.58.07.0363].

* To overwrite the skdes in the study with the slides from the archive,
choose Overwrite. As above, this option will replace the
newer item in the study with the archived version.

* To add the slides from the archive and make their names unigue,
choose Make Unique. The names are made unique by
adding the date and time after the name, as above.

The application will display a message when the restoration
1s complete.

Viewing and Arranging Tools

You can show or hide the tools by selecting the appropriate item
from the Tools menu.

Arrange the tools the way you want them on the desktop. The next
time you log into the application, the tools will appear where you
left them when you last logged out.

Look in: I \) Liza's

-l & &k E-

|

File name: |1 .agl

Open I

Files of type: IApex Archive Files [* azt" asl)

™ Open as read-only

j Cancel |

4
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The Static Image Annotations Toolbar

The Static Image Annotations Toolbar contains tools that allow
you to add text and graphics to a static image (these are referred to
as annotations). If you save the static image, the annotations are also
saved.

Region of Interest — Used to define the area of interest on the
roadmap when creating a static image. Click and drag to define the Click

. . .. N Arrow Radial grid
region of interest. See “Acquiring a Static Image” on page 45 for Line color polygon ?
information on using this tool. / / /

Line Color — Allows you to change the line color of static

annotations for anything drawn this session. You can also change Static Image Annoktati

the cglor for a sPcciﬁc static ann(?tatior} by right—cli'cking it gnd DlHl Al A | o | Ql |:|| I

sclecting Properties. In the resulting dialog box, click the Line

Properties tab and make the changes. \

Text — Allows you to type text on the static image. Click and drag Regionof eyt Polygon  Rectangle
interest

from the upper left to the lower right to draw a text box, then click
again on the Text tool to turn it off. Finally, click in the box to type
the text. Use the Annotations Font Toolbar to change the font, its
size and style; see ““I'he Annotations Font Toolbar” on page 93.

Arrow — Allows you to draw an arrow on the static image. Click to
create the head of the arrow, then drag in any direction to create
the other end of the arrow. You can adjust the position of the
arrow by right-clicking it, selecting Adjust Arrow, then clicking
and dragging the end you want to move.

Polygon— Allows you to draw a closed region on the static image.
Click and drag to draw the region then release the mouse button to
close the region.

Click-Polygon— Allows you to draw a closed region on the static
tmage. Click at the starting point, then click to form each side of
the region then double-click the mouse button to close the region.

Rectangle — Use this tool to draw a rectangle on the static image.
Click to place the upper left corner, then drag to the lower right to
form the rectangle.

Radial Grid — Places a radial grid on the static image. Click once
to place a radial grid on the static image. After creating the radial
grid, you can change the line width and color, number of rings and
the spacing between rings to use the radial grid as a scale (see
“Adjusting Radial Grid Properties” on page 92).

Moving the Static Image Annotations Toolbar

The toolbar floats in the application window as do all the other
tools. You can drag it directly under the menu bar to dock it, if
desired.

. To move the toolbar, click on the border and then drag it to the
desired location.
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*  To change the toolbar’s dimensions, hold the mouse over the edge
of the toolbar’s border until the cursor changes to a double-
headed arrow, then click and drag to change the width.

Adding Annotations to a Static Image

1. Click on the static image to activate the Static Annotations
Toolbar.

2. Click on the individual tool to activate it.
3. Draw on the image as desired.

4. C(lick the tool again to turn it off.

Working with Annotations

Once you create an annotation, you can move, hide, or delete it
You can also show its properties.

. To move an annotation, move the mouse over the annotation,
hold down the ALT key and the left mouse button then drag
it to a new location on the static image.

. To hide an arrow annotation, right-click it and select Hide. -
When the cursor is over a hidden annotation, it changes to a '\.l-l.
hand with red lines radiating from it. You can redisplay it by -
right-clicking the area where the hidden annotation is and i

select UnHide.

. To delete an annotation, right-click the annotation and select
Delete.

o To show the properties of an annotation, right-click the annotation
and select Properties to view the Annotations Properties
dialog box. See “Adjusting Annotation Properties”, below,
for information on changing the annotation properties.

Adjusting Annotation Properties

You can adjust various attributes of an annotation.

Adjusting Color and Line Width
You can change the color and line width of the line, rectangle,
region and radial grid annotations.

1. Right-click the annotation and choose Properties. S x|

Depending on the annotation you selected, the dialog box _ _
. Line Properties |
will vary.

2. If necessary, click the Line Properties tab.

Change "width
Change Color |

QK | Cancel | Apply | Help

Version C 888.446.7911 650.962.3020 techsupport@arctur.com www.arctur.com 91



Veritas™ Microdissection Instrument

3.

You can make the following line adjustments:

* To change the line width, click Change Width, enter a number
from 1 to 10, and click OK Click OK in the Line
Properties dialog box.

» To change the line color, click Change Color, sclect a color in
the color dialog box, and click OK. Click OK in the
Annotations Properties dialog box.

Adjusting Radial Grid Properties
You can change the number of rings, and their interval, for radial

grid annotations. You can also change the line width and color of
the rings.

1.

Right-click a radial grid annotation and choose Properties
from the menu.

X

e
’ Cahicel |

Color E3

Basic colors:

LCustom calors:

O o
R A

Diefine Custam Colors »> |

Ok I Cancel |

Fiadial Grid Propertiez | Line Properties I

2. You can make the following adjustments to the radial grid:
» To change the number of rings, enter a number, then click
Apply or OK _
o To change the distance between rings, enter the distance (in Humberofing: E
microns) between rings, then click Apply or OK.
 To change the Line Properties, click on the Line Properties tab [F_“ng_inte“’]a' [25
and make changes as described in “Adjusting Color and
Line Width”, above.
3. Click OK to close the dialog and save changes.
ak I Cancel Lpply Help
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The Annotations Font Toolbar

You may change the font, style, size and/or color for a text
annotation by seclecting the corresponding option in the
Annotations Font Toolbar.

To make font changes, do one of the following: Font

. Click the font text box on the annotation, then select the /
appropriate font feature from the Annotations Font Toolbar. -
Right-click on the annotation text and select Change Font -
* gt S - = u
to display the standard Windows font dialog box, which System =l = ﬂﬂg
llows t ke all of th ilable font ch ,
allows you to make all of the available font changes \Fontsize \Fontstyle

including color.

As with the Static Image Annotations Toolbar, the Annotations
Font Toolbar can be dragged from its default location to be
docked under the menu bar, if so desired.
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7. Maintenance and Troubleshooting

A CAUTION: Do not attempt to remove the covers from the
instrument except as specified for the user-serviceable parts
described on page 100. If the instrument requires service or repair
contact Arcturus Bioscience at 1 (888) 446-7911.

Cleaning the Veritas Instrument

. Clean the outside of the instrument using a damp cloth. Do
not use any solvents or abrasives.

*  Clean the work surface, as necessary, by wiping it with a
cloth moistened with ethanol.

Troubleshooting

If you encounter a problem that you cannot resolve using this
troubleshooting section, contact Arcturus Bioscience in North
America at 1 (888) 446-7911, or in Europe at [00] (800) 2728-8787.
You can also send email to techsupport@arctur.com or contact
your local distributor.

To minimize the time to diagnose and correct your problem, you
may be asked to perform all or a portion of the Operational
Qualification Procedure by Arcturus Bioscience technical
support. This procedure is found in document #13801-00 on the
Veritas installation CD.

Starting the Application

Database errors given.

*  Upon starting the program, the application creates backup
copies of the application’s databases (where the images and
user information are stored) for safekeeping. After the copy,
the application compresses the databases. This is done to
improve performance during the session.

If the compression fails, the application will display the
message “An HError Occurred While Compressing Database.
You Can Continue With Normal Operations.”. The system
will then attempt to automatically restore the databases from
the backup copies.

If the restoration fails, the application will display the
message “SERIOUS FAULT: The database [Database File
Name] does not exist. You Can NOT Continue With
Normal Operations, the application will exit after you click
OK. CONTACT TECHNICAL SUPPORT”. In this case,
you will need to manually restore the databases.

To do this, exit the Veritas application. Locate the backup
databases in the C:\APEX_Databases folder. They will have
the “.bak” file extension. Copy the backup files to a different
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location on your hard drive. Rename the files in the
C:\APEX_Databases folder by removing the “.bak” from
the name. Launch the Veritas application.

Images

Roadmap image appears white.

e The lamp intensity it set too high. Reacquire the roadmap
image by right-clicking on the slide in the Materials Tool.
Select Acquire Roadmap Image, then click Yes to readjust
the light intensity.

The live video image appears white.

*  'The area of interest you are viewing is clear glass and not
tissue. Click and drag the red view indicator on the roadmap
to an area of tissue.

The live video image appears black.

*  The lamp intensity is set too low. Use the Microscope Tools
to turn up the lamp intensity.

*  The objective turret failed to index properly. Open the door
and manually rotate the objective to the set objective
position.

Roadmap and live video windows are blank.

*  The computer was in “Hibernate” or “Standby” mode, due
to a lack of activity. Exit from the application and restart the
computer. To prevent this in the future, disable Hibernate
in the Power Options Properties control panel and change
System standby.

To make these changes to your system, log in to an account
with Administrator privileges. Right-click on the desktop
and select Properties -> Screen Saver -> Power. Click the
Hibernate tab. In the tab, uncheck Enable hibernate
support. Click on the Power Schemes tab and sct Select
System standby to Never. Click OK to close the dialog box.

(apture

Cells do not adhere to the film.

*  Hnsure wetting is adequate. Check the wetting (See “Iest
Firing the Capture Laser” on page 50).

*  The cap 1s not seated properly on the tissue. Try firing the
laser at four points around the edge of the capture area of
the cap (up, down, right, left) to see if the wetting is
consistent. If necessary, move the cap to a new location.

*  Hnsure your tissue preparation technique is correct (see
“Iissue Preparation” on page 17). If necessary, dehydrate
the sample in 100% EtOH for 1 minute, followed by xylene
for 5 minutes.
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Cap is moved randomly.

*  Turn off Auto Cap Placement in the User Preferences (see
“Setting User Preferences” on page 36) and use a new cap.

(apture Laser

Cannot find the capture laser targeting beam.

* A cap has not been placed on the slide. You must place a cap
before you can see the laser beam.

*  You may need to adjust the shutter speed and dim the
background lighting to see the laser-targeting beam. Use the
slider control under LLamp Intensity in the Microscope Tools
to lower the lamp intensity. If the laser is difficult to see even
at low light intensity, reduce the camera shutter speed to 1/
50. See “Camera Control Dialog” on page 68 for
instructions on setting the shutter speed.

*  Change to a lower objective to sce a larger field of view and
re-focus the laser.

*  Tissue is very thick or dark. Move to thinner tissue or an
empty area of the slide.

*  Laser 1s out of focus. Focus the laser beam (See “Manually
Focusing the Capture Laser Beam™ on page 49).

*  Laser targeting beam is too weak to see. Turn the white light
off. Increase the Laser Intensity on the Capture Laser Tools
and click Set.

*  You can try firing the laser to locate the beam. Fire within
the area of the cap—away from tissue if using a Macro Cap,
or outside the circle if using an HS Cap.

“Laser has not been located” message appears.

. Locate the laser beam as described in “Manually Locating
the Capture Laser” on page 50.

Capture laser beam is fuzzy.

*  The laser is not focused. See “Manually Focusing the
Capture Laser Beam” on page 49.

* A cap was not placed. Place a cap.

*  The cap may be damaged. Try placing another cap.

Capture laser will not fire.

. The laser 1s not enabled. Click the Enabled check box at the
top of the Capture Laser Tools window.

NOTE: You may not always sce the flashes from the laser
beam as it fires since they are shorter than many of the
shutter settings used. If the laser has been properly focused
you will see the laser wetting. If in doubt, use the Light
Intensity slider in the Microscope Tools to darken the
background and move to a position on the slide where there
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1s no tissue. (If the laser is difficult to see even at low light
intensity, reduce the camera shutter speed to 1/50. See
“Camera Control Dialog” on page 68 for instructions on
setting the shutter speed.) Fire the laser again, then adjust the
light intensity to the previous illumination.

Capture laser fires off target.

The laser beam location was set inaccurately or the objective
was changed. Relocate the laser beam as described in
“Manually Locating the Capture Laser” on page 50.

Measure the spot size, then adjust the size, if necessary.

Cannot achieve proper wetting when capture laser is fired.

Ensure the laser settings are correct (See “Manually
Focusing the Capture Laser Beam” on page 49.).

The cap is not seated propetly on the tissue. Try firing the
laser at four points around the edge of the capture area of
the cap (up, down, right, left) to see if the wetting is
consistent. If necessary, move the cap to a new location.
Tissue may have folds or an uneven surface. Make sure the
slide has been treated with a PrepStrip. If the problem
occurs, move to a different section of tissue. If the problem
occurs regularly, check the sample quality, microtome blade,
and sectioning techniques.

The cap may be damaged. Tty another cap.

Cutting Laser

Laser does not cut.

Select the Cutting Laser Tools from the Tools menu.
Increase the power and click Pulse to fire the laser. You
should see a small (1-5 microns) hole in the tissue in the
center of the live video window. If not, increase the power
again.

Auto Scan

Application worked when training but not on new tissue
sections.

Application needs more training information. Create
multiple training files using various tissue sections. Combine
the files to create a file that incorporates all of the
information.
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System Error

If you see a system error, please make a note of the ID and
error numbers. (In the example, ID = 25 and Error = 102.)
Arcturus Technical Support can use this information to
determine the severity of the problem. A system error is
typically followed by an instrument error message. The type
of message indicates the degree of severity, as discussed
below.

Fatal Instrument Error

A fatal instrument error may indicate a serious issue. However, it
may just mean that a cap was dropped during handling. Please note
the two example messages to the right and the discussion below.

Cap Handling Error

See the message to the right. In this case, the instrument
door will open once you click OK. Please remove all caps
from the QC and the unload tray and check the work surface
for any loose caps. You can immediately restart the
application and continue working;

Contact Arcturus Technical Support if this persists.

Other Fatal Instrument Errors

See the message to the right. If you see this message, please
contact Arcturus Technical Support before continuing to use
the Veritas Microdissection Instrument.

AutoPix 100 x|

' Sysbem error: Component ID = 25, Error = 102
. Please make note of the 1D and Error number

Fatal Instrument Error ﬂ

An unrecoverable eror hazs occured while placing a Cap. Press OF
to remove all Caps from OC, Unload and Fork, AutoPix software iz
initiating an automatic shutdown

Fatal Instrument Error ﬂ

A hardware emor has occurred. The host is initiating a shutdown,
Pleaze make note of the error numbers fram the previous screen
and cantact Arctunug Technical Suppart before continuing to use
your systeml techsupportEarctur. com
1-8838-446-7311 in Morth America and [00] 800-2728-8787 in
Europe
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Checking Lamp Hours

Each of the lamps in the instrument has a finite lifetime. Check the
accumulated hours as follows:

1. Sclect System Info from the Help menu to display the x|

Veritas About Box.
System Info  Lamp Info |

2. Click System Info. In the System Information dialog, click R g——— "

Lamp Info. Foadmap Bottam Lamp: 12 hours
- p . . . Roadmap Top Lamp: 40 hours
T'he accumulated hours for each lamp is shown in the dialog EPI Lamp: 30 hours

box. Operating Hours: 2141 hours

* The fluorescence lamp’ typical lifetime is 1500 hours. At

4000 hours, the lamp will not strike. Feset |
* The bright-field illumination lamp (listed here as

“Condenser Lamp”) typical lifetime is 100 hours. Help |

3. Click OK to close the dialog,

4. C(Click OK to close the Veritas About Box.

User Serviceable Parts

The Veritas™ Microdissection Instrument has only four user-
serviceable parts:

. the bright-field illumination lamp

*  the user-interchangeable fluorescence filter cube, for Model
702 and Model 704 instruments

. the fluorescence lamp, for Model 702 and Model 704

instruments
. the fuse

Other than replacing these components, and for transport,
unpacking or operational qualification as per Arcturus Bioscience
instructions, the covers should not be removed from the
instrument unless authorized by a qualified Arcturus Bioscience
service representative.

Replacing the Bright-Field lllumination Lamp

After replacing the lamp, you must also reset the counter for the
lamp hours. Follow the directions below:

You will need the replacement lamp, a #2 Phillips screwdriver and
clean, powder-free gloves for this procedure.

1. If needed, exit the Veritas application. Turn the instrument
off and unplug it. (When you are facing the instrument door,
the switch and plug are located on the left side, near the
back.)

2. Hacing the back of the instrument, remove the shaped top
cover of the instrument. Near the center of the instrument,
loosen the two screws that hold the cover. Slide the cover

100  www.arctur.com techsupport@arctur.com 650.962.3020 888.446.7911 Version C



Maintenance and Troubleshooting

towards you a few inches, then lift it up and off. Place the
cover in a safe location.

3. DPull the black lamp housing vertically up and out. Pull the
used bulb vertically out of the socket.

lamp housing

A CAUTION: Hot Surface!

The lamp housing may be hot.

A CAUTION: Possible Pinching!
Keep fingers clear of the door mechanism. /\ /.\
. == .
4. Wearing clean, powder-free gloves, open the new lamp. Plug

the lamp into the socket and replace the lamp housing into

the instrument.

5. Replace the shaped top cover, sliding it forward to seat it into
the front cover, then tighten the screws.

6. Plug the instrument in and turn it on.

7. Restart the Veritas application and log in.

System Information 5[

System Info  Lamp Infa I

8. Sclect System Info from the Help menu to display the
Veritas About Box.

. o : : : Roadmap Bottom Lamp: 12 hours
9. Click System Info. In the System Information dialog, click Roadmap Top Lamp: 40 hours

EFI Larmp: 30 hours
Lamp Info. Operating Hours: 2141 hours

10. Double-click on the row that says “Condenser Lamp” to

select it, then click Reset. Fleset |
This resets the lamp hours to 0.
NOTE: Be careful to select the correct row. If you reset the EE

wrong lamp, the counter for that lamp will be incorrect.
11. Click OK to close the dialog box.
12. Click OK to close the Veritas About Box.

Interchanging Fluorescence Filter Cubes

When sclecting alternate fluorescence filter cubes, you should
ensure the dichroic and emission filters have at least 65%
transmission at 810nm. Compatible filter holders include the
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Chroma #91018 Olympus Filter Cube and the Omega XC113
Olympus Cube.

You will need a 2 mm hex key and the filter cube of choice for this
procedure.

1. If needed, exit the Veritas application. Turn the instrument
off and unplug it. (When you are facing the instrument door,
the switch and plug are located on the left side, near the
back.)

2. Slide the door up to open it. (You must manually hold the
door open for the rest of the procedure.)

3. Unscrew the two screws on either side of the black sheet
metal dust shield. Lift the dust cover straight up, then out of
the mstrument. Place the cover in a safe location.

4. Loosen the set screw for the filter you wish to remove with
the 2 mm hex key. Slide the filter cube straight up.

5. Slide the new filter down until it 1s seated. Check the
orientation of the filter to be sure it matches the other filters,
then tighten the set screw until it is snug.

6. Replace the dust shield, tightening the screws by hand until
snug. The door will close when you release it.

7. Plug the instrument in and turn it on.

Replacing the Fluorescence Lamp

You must first remove the access panel before you can replace the
lamp. Once you have replaced the lamp, you will need to reset the
counter for the lamp hours.

You will need the new fluorescence lamp, a 3mm hex key
(provided with the instrument) and a slotted screwdriver for this
procedure.

1. If needed, exit the Veritas application. Turn the instrument
off and unplug it. (When you are facing the instrument door,
the switch and plug are located on the left side, near the
back.)

2. lHacing the back of the instrument, unscrew the two
thumbscrews on the upper right side to remove the access
cover. (You may need to use the slotted screwdriver.) Pull the
cover back and remove it.

3. Remove the 3mm hex key from the clip in the access cover.
Place the cover in a safe location.

4. lollow the steps in “Installing the Lamp Module” on
page 112 to replace the lamp itself.
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10.

11.

12.

Replace the access cover and tighten the screws.
Plug in the instrument and turn it on.

Restart the Veritas application and log in.

Sclect System Info from the Help menu to display the
Veritas About Box.

Click System Info. In the System Information dialog, click
Lamp Info.

Click on the row that says “EPI Lamp” to select it, then click
Reset.
This resets the lamp hours to 0.

NOTE: Be careful to select the correct row. If you reset the
wrong lamp, the counter for that lamp will be incorrect.

Click OK to close the dialog box.

Click OK to close the Veritas About Box.

Replacing the Fuse

You will need the new fuse (6A, time delay, 5 x 20 mm) and a

slotted screwdriver for this procedure.

1.

If needed, exit the Veritas application. Turn the instrument
off and unplug it. (When you are facing the instrument door,
the switch and plug are located on the left side, near the
back.)

The fuse 1s located on the left side of the instrument, between
the switch and the power cord. Use the slotted screwdriver to
open the fuse holder.

Remove the fuse and replace it with the new one. As you are
facing the switch, the fuse goes into the right side of the
holder. Slide the fuse holder into the instrument and flip the
cover up.

Plug in the instrument and turn it on.

System Information

System Info  Lamp Info I

Condenger Lame: 295 hourg

Foadmap Baottam Larmp: 12 hours
Roadmap Top Lamp: 40 hours
EPIl Lamp: 30 hours

Operating Hours: 2141 hours

Feset |

Help |
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Specifications

Specifications
Veritas™ Instrument

Electrical Supply:

Fuse:
Capture Laser:

Cutting Laser:
(Models 703 & 704 only)

Filters:
(Models 702 and 704 only)

Bright Field Hlumination:

Fluorescence Light Source:
(Models 702 & 704, only)

Operating Temperature:

Operating Humidity:

Dimensions:

Weight:

Work Surface
Requirements:

Altitude:

100-240 VAC, 5060 Hz, 600W
(voltage fluctuations not to exceed
110% of nominal supply voltage)

6A, time delay, 5 x 20 mm

laser diode, 810 nm

Diode-pumped solid-state UV laser,

349 nm

Color Excitation Emission
Red: 570—630 nm >655 nm
Green: 503-548 nm >565 nm
Blue: 455495 nm >510 nm
Optional

uv: 340-390 nm >410 nm

120W/, 1500 hour metal halide
fluorescence lamp
(Arcturus catalog number 10124-00)

EXFO X-Cite™ 120 fluorescence
illumination system

18°-30°C

<60% relative humidity
(noncondensing)

Height: 30 in. (76 cm)
Width: 36 in. (92 cm)
Depth: 27 in. (69 cm)
265 1b (120 kg)

38 1. x 72 in. (97 cm x 180 cm) with
32 in. (80 cm) vertical clearance

For use up to 6600 ft. (2000 m)

The Veritas instrument complies with the following standards:

*  IEC 664 — Installation Category 11
*  IEC 664 — Pollution Degree 2

Version C
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. EN 60825-1 and IEC 60825-1 — Safety of laser products —
Part 1: Equipment classification, requirements, and user’s
guide, Section Two-Manufacturing requirements

* EN 61326-04:1997+A106:1998+A2:2001 (Emissions and
Immunity) — Electrical equipment for measurement, control,
and laboratory use — EMC requirements

* EN 61010-1 and IEC 61010-1 — Safety requirements for
electrical equipment for measurement, control, and
laboratory use — Part 1: General Requirements.

NOTE: This equipment has been tested and found to comply with
the limits for a Class A digital device, pursuant to part 15 of the
FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is
operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may
cause harmful interference to radio communications. Operation
of this equipment in a residential area is likely to cause harmful
mnterference in which case the user will be required to correct the
interference at his own expense.

Computer

* 2.8 GHz Pentium 4 processor (minimum)

* 40 GB hard drive (minimum)

*  Windows® XP Professional operating system

. Read/write CD drive

*  Flat panel LCD monitor, 1280 x 1024 pixels, true color
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Appendix A - Keyboard Commands

The following table lists the keyboard commands in the Veritas

application.
Window Keys Notes
Microscope Arrow keys (UP, Adjusts Fine Focus
Tool DoOwN, RIGHT and
LErT)
Live Video Arrow keys Move stage in the direction of
the arrow key
C1rL+arrow key Move stage 1/2 frame in the
direction of the arrow key
ALT+CLICK Select dissection mark or
annotation
AL1T+X Turn cutting laser on and off
CIRrR1ASHIFL Turn cutting laser on while keys
are depressed
Any cditable CTRL+C Copy text
text field
CTRL+X Cut text
CTRL+V Paste text
Crr1+U Undo last text edit
Esc Exit text field with no changes
Capture Up and DOWN Move through list of capture

Groups Tool

arrow keys

groups and make group active

RIGHT and LEFT

Move cursor through capture

arrow keys group columns
Roadmap Arrow keys Move stage in the direction of
the arrow key
CTRL+arrow key Move stage 1/2 frame in the
direction of the arrow key
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Window

Keys

Notes

Cutting Laser
Tool

Arrow keys (Up,
DOwWN, RIGHT and
LEFT)

Change cursor position

Any

F1 or Stiirr-F1

Opens PDF version of this

manual
CTRL+N Start new session
CTRL+D Load default settings
CTRL+Y Create new study
Crr+U Open User Preferences dialog

Show all tools (unless active
window is a tool)

CTRL+H Hide all tools (unless active
window is a tool)
Any tool or CTRL+P Prints 17x 37 version of

the roadmap

roadmap

A static image

C1Rr1L+P

Prints a thumbnail (17 x 1 1/4”)
of the static image
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Appendix B - Fluorescence Lamp Information

This appendix provides information about the EXFO X-Cite 120
fluorescence lamp supplied as with Model 702 and Model 704
mstruments, including instructions on changing the lamp.

Safety Precautions

The EXFO X-Cite 120 is equipped with two safety sensors to
protect the user from accidental UV exposure. In addition,
please observe the following precautions during use. This
series of cautions, warnings and dangers relate to the
operation and maintenance of the EXFO X-Cite 120. They
are also presented throughout this chapter where necessary.

Warning

Eye damage may result from directly viewing the light produced by
the lamp used in this product. Always use protective eye wear and
turn the lamp off before removing cover.

Caution

Never look into the light emitting end of the light guide. The light
could severely damage the cornea and retina of the eye if the light
is observed directly. Eye shielding must be used at all times as well
as clothing to protect exposed skin.

Warning

Always make sure the light guide is propetly inserted into the
EXFO X-Cite 120 and the microscope prior to turning on power
to the unit. This will minimize the risk of exposure to the UV light.

Warning

To reduce the risk of fire or shock, always replace the fuses with
the same type and rating,

Warning

Disconnecting of main supply source is only possible by
unplugging the power cord.

Danger

This unit contains HIGH VOLTAGE components. It is
recommended that ONLY QUALIFIED TECHNICAL
PERSONNEL perform any testing or repairs described in this
manual. Disconnect the AC power cord from the unit before
opening the cover of this unit. All cover screws must be replaced
prior to applying power to the unit, or safety of the unit will be
impaired.

Version C 888.446.7911 650.962.3020

techsupport@arctur.com

www.arctur.com

109



Veritas™ Microdissection Instrument

Monitoring the unit during manual operation

The level of UV energy supplied by the EXFO X-Cite 120 is
sufficlent to ignite flammable substances. During manual
operation, the unit must be attended at all times by a qualified
operator. The unit must not be left unattended while turned on. If
an operator leaves the work areca of the unit, the lamp power
switch must be turned off.

Monitoring the unit during automated operation

The level of UV energy supplied by the EXFO X-Cite 120 is
sufficient to ignite flammable substances. Therefore, when the unit
is operated unattended in an automated environment, an alarm
function must be provided by the user to indicate a malfunction in
the associated equipment used.

Warning
Hg — LAMP CONTAINS MERCURY!

Manage in Accord with Disposal Laws, see:
http:/ /www.lamprecycle.org or 1-800-668-8752.

Danger

When unpacking or installing the lamp, always wear protective
clothing and a face mask. Operate lamp only in the EXFO X-
Cite 120 lamp housing. This prevents direct viewing of the arc and
in the case of lamp bursting, contains lamp particles. In the rare
instance in which a lamp bursting occurs, and the mercury content
1s released, the following safety precautions are recommended: All
personnel should be immediately evacuated from the area to
prevent inhalation of the mercury vapor. The area should be well
ventilated for a minimum of 30 minutes. After the lamp housing
clements have cooled, the mercury residue should be collected
with the use of a special absorbing agent available from laboratory
equipment suppliers.

Warning

Should this EXFFO X-Cite 120 unit be used in a manner not
specified by EXFO, the protection provided by the equipment
may be impaired.

Caution

The lamp module’s operational life can be significantly shortened
if it 1s handled incorrectly. Do not touch the bulb’s glass envelope
or the inside surface of the reflector. Skin oils can cause the lamp
module to fail prematurely.

Caution

Prior to opening the unit and handling the lamp module, allow the
lamp module to cool down completely.
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Caution

Any eclectronic equipment connected to the EXFO X-Cite 120
must be IEC950 certified.

Cleaning

Clean exterior of the unit with a water dampened cloth and simple
detergent only.

EXFO X-CITE 120 Message Reference

The table below lists various messages you may see on the lamp
display (inside the Veritas™ Microdissection Instrument; these are
not visible when the instrument’s covers are in place).

Symbol | Message Description
XXXX. | Lamp Displays the accumulated hours the

Hours lamp has been on.

XXX.X | Exposure Displays the time in seconds the

Time shutter will remain open when acti-
vated.

XXX Iris Setting | Displays the iris setting as a percent-
age of maximum.

Flashing | Flashing The lamp is warming up. Warm up

XXX.X | display time 1s approximately 90 sec.

bulb Bulb Error | Lamp installed incorrectly /
Lamp did not strike or extinguished
after striking

cool Cool Lamp 1s too hot to strike.

Warning The lamp will automatically strike
when it has reached optimum strik-
ing temperature.

old/bulb | Alternating | The lamp has accumulated over
“Ol1d” then | 2000 hours. Lamp may be near end
“Bulb” of life.

end/ Alternating | The lamp has accumulated over

bulb “End” then | 4000 hours. The lamp will not

“Bulb” strike.

LOC Adjustment | The UP/DOWN adjustment buttons

Locked have been locked. No changes can
be made to the exposure time or iris
setting;

ULOC Adjustment | The UP/DOWN adjustment buttons

Unlocked have been unlocked. Changes can
be made to the exposure time and
iris setting

SFI Shutter The shutter has failed. Unit should

Failure be restarted. If the error repeats unit
should be serviced.
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Installing the Lamp Module

You will need the new fluorescence lamp, a 3mm hex key
(provided with the instrument) and a slotted screwdriver for this
procedure.

1.

5.

Be sure the instrument is turned off and the power cord is
disconnected from the instrument. (When you are facing the
instrument door, the switch and plug are located on the left
side, near the back.)

Remove the access cover from the Veritas™ Microdissection
Instrument as directed in “Replacing the Fluorescence Lamp”
on page 102.

Using the 3mm hex key located in the clip in the instrument
access cover, remove the lamp access panel from the unit
cover.

Lamp access cover

Carefully remove the lamp module from its container,
holding only the ceramic components.
Caution: Handle bulb carefully!

The lamp modules operational life can be significantly
shortened if handled incorrectly. Be sure only to handle the
ceramic surfaces. Do not touch the bulb’s glass envelope or
the inside surface of the reflector. Skin oils can cause the
lamp module to fail prematurely.

Open the lamp bracket arm by pulling towards you and to the
right.
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Lamp power connector Lamp bracket

Lamp spring clamp o l
‘
L

Intelli-Lamp connector B |

Lamp bracket arm

6. Position the lamp so that the two leading edges of the lamp
ceramic mount slide into the groove of the lamp bracket. The
middle of the lamp should be in position to fit into the spring
clamp.

THIS SIDE OUT label

Tip: Make sure that the “This side out” label is facing
outwards before trying to insert the lamp as illustrated below.

7. Slide the lamp all the way in so that both leading edges of the
lamp ceramic mount are in the groove of the lamp bracket.
The middle of the lamp will snap into the spring clamp. Close
the lamp bracket arm.

8. lLocate the 4-pin Intelli-Tamp sensor connector (¢/w multi-
colored wiring harness) at the rear of the lamp module and
connect it to its mate located on the lamp-housing wall.
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Tip: The Intelli-Lamp connector will only attach in the
correct orientation. If you are having difficulty attaching the
connector, try rotating it by 180°.

9. Attach the 2-pin lamp power connector to its mate on the
lamp-housing wall.

Tip: The 2-pin lamp power connector will only attach in the
correct orientation. If you are having difficulty attaching the
connector, try rotating it by 180°.

10. Ensure the Intelli-Lamp sensor and the lamp power leads are
secured into the appropriate alignment grooves of the lamp
housing as illustrated below.
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11. Replace the lamp access side panel and tighten the fastening
screw.
NOTE: If the lamp module has been installed incorrectly the
message “bulb” will appear on the display and a continuous
audible beep will be heard after the 90 second warm-up cycle
has been completed.
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Index

Index

A
ablation
at QC station 26
definition 13
keyboard shortcut 26
Ablation Exclusion Region tool 23, 82
Ablation tools 23
Ablation Exclusion Region 23, 82
Free-Form Ablation Region 23, 82
activating
Microdissection Tools 80
slides 20
Static Image Annotation Tools 91
Study Tool 87
AGC 68
annotations
adding to static image 91
adjusting color and line width 91
arrow, hiding 91
deleting 91
fonts 93
moving 91
properties 91
showing 91
Annotations Font Toolbar 93
arranging tools 89
Arrow tool 90
Auto Brightness Adjust user prefer-
ence 38
Auto Cap Move user preference 37
Auto Cap Placement user preference
36
Auto Focus user preference 37
Auto Locate LCM Laser user prefer-
ence 37
Auto Scan 55
combining training files 61
harvesting cells 61
morphology analysis 56
pixel analysis 56
texture analysis 56
Auto-acquire Roadmap Images user
preference 36
automatic gain control 68
AutoPix 100e compatibility 20, 37, 53,

68
Autoscan tool 80
AWC 69

B

bar code 37

bitmap format 48

blue + 50

bright-field lamp
replacing 100
specification 105

C

calibration matrix 78
cap insertion tool 16
cap interaction history 26
caps
active 41
associated with slide 40
auto-placement 36
capturing entire cap region 65
extracting material from 28
HS Caps 15
image of entire cap region 46
loading 15
Macro Caps 15
moving to QC 42
naming 25
placing on slide 41
properties 87
removing from instrument 26
renaming 43
total area 43
total laser fires 43
unloading 42
with red circle 41
CapSure™ LCM Sample Preparation
System 15
capture groups
arca of group 73
creating 24
naming 24
properties 74
reviewing items in the group 25

Capture Groups Tool 73
capture laser
auto locating 37
calibration matrix 78
focusing 49
locating 49
measuring spot size 51
repeating captures 64
specification 105
spot properties 91
troubleshooting 97
Capture Laser Tools 76
cell capture, troubleshooting 96
Circular Cut and Capture tool 22, 81
Click-Polygon tool 90
color and line width 91
computer specifications 106
copying
slides 87
text 107
user preferences 35
cropping 66
Cut and Capture tools 80
Circular Cut and Capture 22, 81
Free-Form Cut and Capture Re-
gion 22, 80
cutting laser
displaying location 37
measuring spot size 78
pulsing 78
repeating cuts 64
setting power 79
setting to default values 78
specification 105
troubleshooting 98
Cutting Laser Tools 78

D

daily activity report 63

database errors 95

Default Capture Mode user preference
36

Default Filter Selection user preference
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36
default user name 34
deleting
annotations 91
dissection marks 82
images 38, 48, 87
slides 87
stored positions 85
studies 87
digital noise reduction 69
Dissection Exclusion Region tool 23,
81
Dissection Line tool 23, 81
dissection marks
creating 80
definition 21
deleting 82
hiding 82
moving 82
properties 83
sclecting 82
showing 82
Dissection Region tool 23, 81
DNA
extraction 27
isolation 18
DNR 69

exporting images 48
extraction kits 27

F
fatal instrument errors, troubleshoot-
ing 99
File menu 63
filters
default 36
neutral density 68
opening 51
replacing 101
sclecting 67, 84
fluorescence filters
replacing 101
specifications 105
fluorescence lamp
activating 52

replacing 102, 112
specification 105
turning off 52
fluorescence staining 18
focusing
capture laser 49
live video image 51
microscope 83
font color 93
Free-Form Ablation Region tool 23, 82
Free-Form Cut and Capture Region
tool 22, 80
fuse
replacing 103
specification 105

G

gain control 68

Go Capture tool 80
green circle 37

H
Hand tool 80
Help menu 71
hiding
arrow annotations 91
dissection marks 82
tools 89
tools and toolbars 64
HistoGene LCM staining kits 18

|

image capture settings 66

Image menu 64

images
associated with slide 40
deleting 38, 48, 87
exporting 48
formats 47
live video 44
margins 66
opening 38, 47, 87
properties 87
renaming 47
roadmap 43
saving 47

static 45
troubleshooting 96
types of 33
installation
instructions 7
qualification 12
instrument
carrying instructions 7
cleaning 95
installation instructions 7
laser configurations 13
model numbers 13
opening door 67
specifications 105
Instrument menu 66
integration 68
IR laser, See capture laser

J
JPEG format 47, 48

K

keyboard shortcuts
ablation 26
adjusting light intensity 83
adjusting microscope focus 83
moving the stage 20
selecting a capture group 74
table 107

L

lamp hours
resetting 101, 103
viewing 100

laser and microscope settings
loading 63, 86
renaming 63
saving 85

laser capture microdissection
definition 14

laser matrix 78

Laser Tool Shows Fire Counter user
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Index

preference 37
Laser Tools 76
LCM definition 14
LCM tools 81
Dissection Exclusion Region 23,
81
Dissection Line 23, 81
Dissection Region 23, 81
Single Point Dissection 23, 81
light source
See bright-field lamp
See fluorescence lamp
Line Color tool 90
live video image
blue + 50
creating static image from 45
displaying a different arca 45
focusing 51
green circle 37
opening 44
troubleshooting 96
zooming 65
loading
caps 15
slides 15
logging in 19, 34
logging out 31, 34

manual, PDF version 16
margins 66
materials
automatically detecting 37
manually loading 67
unloading 31
Materials menu 70
Materials Tool 79
active cap 41
active slide 39
changing study 79
moving stage from 45
new session 79
opening door 79
membrane slides 16

Instrument 66

Materials 70

Tools 64

User 71

View 63

Window 71
Microdissection Tools 80

Ablation tab 23

activating 80

Autoscan tool 80

common tools 80

Cut and Capture tab 80

Go Capture tool 80

Hand tool 80

L.CM tab 81

Ruler tool 80
microscope

auto focus 83

focusing 83
Microscope Tools 83
model numbers 13
morphology analysis 56, 59
moving

annotations 91

Annotations Font Toolbar 93

dissection marks 82

stage 44

Static Image Annotation toolbar

90

N
Navigation Tool 80, 86

o
opening

images 38

instrument door 79
operational qualification 95

P

Paradise Reagent System 18
parfocality 51, 83

PDF version of manual 16
PicoPure
DNA Isolation Kit 18
RNA Isolation Kit 18, 27
pixel analysis 56, 57
PNG format 48
Polygon tool 90
preferences, user 36
printing 108
properties
caps 87
capture group 74
dissection marks 83
images 87
radial grid 92
slides 87
tabs 75
text annotations 93
viewing from Study Tool 38
pulsing the cutting laser 78

Q

qualification
installation 12
operational 95

R
Radial Grid tool 90
radial grid, properties 92
reagent system 18
Rectangle tool 90
red dotted rectangle 33
red view indicator 33, 44
dragging 45
Region of Interest tool 90
renaming
caps 43
images 47
laser and microscope settings 63
slides 87
studies 87
repeating
captures 64

men;; 6 password cut and capture 65
H (i - changing 35, 71 cuts 04
¢ default user 34 replacing
Image 64 bright-field lamp 100
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fluorescence lamp 102, 112
fluorescent filters 101
fuse 103
reports, See daily activity report
resetting elapsed lamp hours 101, 103
RiboAmp RNA Amplification kit 18
RNA 1solation 18
roadmap image
acquiring 20
automatically acquiring 36, 43
definition 33
manually acquiring 44
moving stage from 45
red dotted rectangle 33
troubleshooting 96
zooming 44, 65
root study name 38
Root Study Name user preference 36
Ruler tool 80

S

safety warnings 5
sample preparation 17
saving
images 47
laser and microscope settings 85
stored positions 84
user preferences 36
sclecting dissection marks 82
Show UV Laser Position user prefer-
ence 37
showing
annotations 91
dissection marks 82
tools and toolbars 64
shutter speed 68
Single Point Dissection tool 23, 81
slides
activating 20, 39
adding to study 39

with red outline 39
software
logging in 19, 34
logging out 34
making selections in 33
starting troubleshooting 95
upgrading 7
spot size
capture laser, measuring 51
cutting laser, measuring 79
increasing 78
minimizing 78
stage
moving from live video 44
moving from Materials Tool 45
moving from roadmap 45
staining kits 18
Static Image Annotation Toolbar 90
static image annotation tools
activating 91
Arrow 90
Click-Polygon 90
deactivating 91
Line Color 90
Polygon 90
Radial Grid 90
Rectangle 90
Region of Interest tool 90
resizing 91
Text 90
static images 45
acquiring from live video image 45
annotating 91
capturing cells 54
entire cap region 46
zooming 65
stored positions
deleting 85
moving to 85
saving 84
studies

system errors, troubleshooting 99
system info, displaying 72
system users

adding 35

deleting 35

editing 35

preferences 36

types 34

T
tabs
definition 25
properties 75
text annotation properties 93
Text tool 90
texture analysis 56, 58
TIFF format 48
tissue preparation 17
toolbars
hiding 64
moving 93
resizing 91
tools
arranging 89
hiding 64, 89
viewing 89
Tools menu 64
troubleshooting 95

U

unloading materials 31

upgrading software 7

Use Barcode Detection user preference
37

Use Material Detection user preference
37

Use Visualizer user preference 36
User menu 71

user preferences 36

copying 87 See a{so study data copying 35
deleting 87 creating 38
loading 15 renaming 87
membrane 16 study data
moving 87 archiving 88
naming 67 deleting 87
properties 40, 87 restoring from archive 88
renaming 87 Study Tool 87
activating 87
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users, See system users
UV laser, See cutting laser

Vv
video settings 70
View menu 63
viewing
lamp hours 100
system info 72
tools 89
visualizer 36

w

warranty 2
wetting
definition 50
troubleshooting 98
white balance 69
Window menu 71
work surface 15
loading 19
unloading 31

Z

zooming
live video image 65
roadmap 44, 65
static image 65
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